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Introduction

This manual describes detailed instructions on the operation and notes about the use of this machine.
To get maximum versatility from this machine all operators are requested to read this manual carefully
and follow the instructions. Please keep this manual in a handy place near the machine.

Important

Contents of this manual are subject to change without prior notice. In no event will the company be
liable for direct, indirect, special, incidental, or consequential damages as a result of handling or oper-
ating the machine.

Trademarks

Macintosh, Mac OS, Apple, AppleTalk, EtherTalk, LaserWriter, Rendezvous are registered trademarks
of Apple Computer, Inc.

Microsoft, Windows, Windows NT are registered trademarks of Microsoft Corporation in the United
States and/or other countries.

Novell, NetWare are registered trademarks of Novell, Inc.

PostScript is a registered trademark of Adobe Systems, Incorporated.

PowerPC is a registered trademark of International Business Machines Corporation.

PCL is a registered trademark of Hewlett-Packard Company.

3Com is a trade mark of 3Com corporation.

Bluetooth is a Trademark of the Bluetooth SIG, Inc. (Special Interest Group) and licensed to RICOH
company limited.

Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights in those marks.
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The proper names of the Windows operating systems are as follows:

• The product name of Windows® 95 is Microsoft® Windows 95.

• The product name of Windows® 98 is Microsoft® Windows 98.

• The product name of Windows® Me is Microsoft® Windows Millennium Edition (Windows Me).

• The product names of Windows® 2000 are as follows:
Microsoft® Windows® 2000 Advanced Server
Microsoft® Windows® 2000 Server
Microsoft® Windows® 2000 Professional

• The product names of Windows® XP are as follows:
Microsoft® Windows® XP Professional
Microsoft® Windows® XP Home Edition

• The product names of Windows ServerTM 2003 are as follows:
Microsoft® Windows ServerTM 2003 Standard Edition
Microsoft® Windows ServerTM 2003 Enterprise Edition
Microsoft® Windows ServerTM 2003 Web Edition

• The product names of Windows NT® 4.0 are as follows:
Microsoft® Windows NT® Server 4.0

• Microsoft® Windows NT® Workstation 4.0
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How to Read This Manual

Symbols

In this manual, the following symbols are used:

R WARNING:

This symbol indicates a potentially hazardous situation which, if instructions are not followed, could

result in death or serious injury.

R CAUTION:

This symbol indicates a potentially hazardous situation which, if instructions are not followed, may re-

sult in minor or moderate injury or damage to property.

* The statements above are notes for your safety.

Important

If this instruction is not followed, paper might be misfed, or data might be lost. Be sure to read this.

Preparation

This symbol indicates the prior knowledge or preparations required before operating.

Note

This symbol indicates precautions for operation, or actions to take after misoperation.

Limitation

This symbol indicates numerical limits, functions that cannot be used together, or conditions in which

a particular function cannot be used.

Reference

This symbol indicates a reference.
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[ ]

Keys that appear on the machine's panel display.

Keys and buttons that appear on the computer's display.

{ }
Keys built into the machine's control panel.

Keys on the computer's keyboard.
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Confirming a Network Environment

Check the environment in which the printer is to be used.

NetWare (Server)

Windows 2000/XP
Windows Server 2003
Windows NT 4.0
(Server)

Macintosh

         NetWare
          (Client)

UNIX

Windows 95/98/Me/
2000/XP

Windows Server 2003

Windows NT 4.0
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❖❖❖❖ Connecting Printer and Computer
• Network connection (Ethernet cable, IEEE 802.11b (Wireless LAN))

• Parallel connection (parallel cable)

• USB connection (USB cable)

• Bluetooth™ Connection

❖❖❖❖ Print Server

• Using Windows 2000/XP, Windows Server 2003, or Windows NT 4.0 Server

• Using NetWare

Windows Configuration

Using a Print Server

This section explains the setup procedure for printing by connecting the printer to a print server network.

There are two procedures: when using a Windows 2000/XP, Windows Server 2003, or Windows NT

4.0 print server, and when using a NetWare server.
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❖❖❖❖ Using Windows 2000/XP, Windows Server 2003, or Windows NT 4.0 Print Server
You can print using Windows 95/98/Me/2000/XP, Windows Server 2003, or Windows NT 4.0 as a

client when using Windows 2000/XP, Windows Server 2003, or Windows NT 4.0 as a print server.

• See p.22 “Printing with a Print Server” in “Windows 95/98/Me Configuration”.

• See p.57 “Printing with a Print Server” in “Windows 2000 Configuration”.

• See p.91 “Printing with a Print Server” in “Windows XP, Windows Server 2003 Configuration”.

• See p.123 “Printing with a Print Server” in “Windows NT 4.0 Configuration”

Windows 2000/XP
Windows Server 2003
Windows NT 4.0
Print ServerPrint Server

Windows 95/98/Me/
2000/XP

Windows Server 2003 Windows NT 4.0



Operating Instructions Client Reference

13

❖❖❖❖ Connecting a NetWare Server
You can print using Windows 95/98/Me/2000/XP, Windows Server 2003, or Windows NT 4.0 as a

client with using NetWare 3.x, NetWare 4.x, NetWare 5/5.1, or NetWare 6/6.5 as a print server.

There are two types of connections: when using the printer as a print server, and when using the

printer as a remote printer.

❖❖❖❖ Using as a Print Server

NetWare
File ServerPrint Server

Windows 95/98/Me/
2000/XP

Windows NT 4.0Windows Server 2003
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❖❖❖❖ Using as a Remote Printer

See p.173 “NetWare Configuration”.

NetWare
Print Server

NetWare
File ServerRemote Printer

Windows 95/98/Me/
2000/XP

Windows Server 2003 Windows NT 4.0
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Not Using a Print Server

This section explains the setup procedure for printing by connecting the printer to a network without a server.

You can print using a Windows 95/98/Me/2000/XP, Windows Server 2003, or Windows NT 4.0.

❖❖❖❖ Network Connection (Ethernet)

• To install the printer driver and required software quickly, refer to p.20 “Quick Install”.

• When you make detailed settings while installing the printer driver and required software, refer to the following.

• See p.28 “Printing without Using a Print Server” in “Windows 95/98/Me Configuration”.

• See p.64 “Printing without Using a Print Server” in “Windows 2000 Configuration”.

• See p.97 “Printing without Using a Print Server” in “Windows XP, Windows Server 2003

Configuration”.

• See p.129 “Printing without Using a Print Server” in “Windows NT 4.0 Configuration”.

Windows Server 2003Windows 95/98/Me/
2000/XP

Windows NT 4.0
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❖❖❖❖ Network Connection (IEEE 802.11b)

❖❖❖❖ Ad hoc Mode (802.11 Ad hoc/Ad hoc)
This is a communication mode used between computers installed with wireless LAN. This is the

most basic form of communication that does not require a relay (access point) between comput-

ers installed with wireless LAN. The computers must be set to the same frequency band (chan-

nel) SSID *1  to enable them to communicate.

It may not be necessary to set SSID *1  depending on the settings of the computers installed with

wireless LAN.

Reference

For details, see about “IEEE 802.11b (Wireless LAN) Configuration”, Option Setup Guide.

❖❖❖❖ Infrastructure Mode
This mode is used to communicate through an access point. If SSID *1  and WEP *2  are set at the

access point, it is necessary to make the same settings. Also, the access point can be incorporated

into an existing network environment by connecting it to a wired LAN (Ethernet).

Reference

For details, see about “IEEE 802.11b (Wireless LAN) Configuration”, Option Setup Guide.
*1 This identifier is referred to as the Service Set ID, and is used when connecting between an access

point and wireless LAN client. Communication is only possible between a wireless LAN client and
an access point sharing the same SSID. Characters can be set using up to 32 alphanumeric characters
and symbols (a distinction between upper and lower case letters is made by ASCII 0x20 - 0x7e).

*2 This is used to protect wireless data communication by encryption. To communicate between an
encrypting access point and a wireless LAN client, the same WEP key must be set for the printer
as well. When using 64 bit WEP, up to 10 characters can be used for hexadecimal, or up to five
characters for ASCII. When using 128 bit WEP, up to 26 characters can be used for hexadecimal,
or up to 13 characters for ASCII.
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• See p.28 “Printing without Using a Print Server” in “Windows 95/98/Me Configuration”.

• See p.64 “Printing without Using a Print Server” in “Windows 2000 Configuration”.

• See p.97 “Printing without Using a Print Server” in “Windows XP, Windows Server 2003 Config-

uration”.

• See p.129 “Printing without Using a Print Server” in “Windows NT 4.0 Configuration”.
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Parallel Connection

This section explains the setup procedure for printing by connecting the printer to a computer using a

parallel cable.

You can print using Windows 95/98/Me/2000/XP, Windows Server 2003, or Windows NT 4.0.

• See p.44 “Printing with Parallel Connection” in “Windows 95/ 98/ Me Configuration”.

• See p.80 “Printing with Parallel Connection” in “Windows 2000 Configuration”.

• See p.113 “Printing with Parallel Connection” in “Windows XP, Windows Server 2003 Configuration”.

• See p.148 “Printing with Parallel Connection” in “Windows NT 4.0 Configuration”.

Windows 95/98/Me/
2000/XP
Windows Server 2003
Windows NT 4.0
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USB Connection

• See p.49 “Installing the Printer Driver Using USB” in “Windows 95/ 98/ Me Configuration”.

• See p.85 “Installing the Printer Driver Using USB” in “Windows 2000 Configuration”.

• See p.118 “Installing the Printer Driver Using USB” in “Windows XP, Windows Server 2003 Con-

figuration”.

Bluetooth™ Connection

p.263 “Printing with Bluetooth™ Connection”

Mac OS Configuration

See p.156 “Mac OS Configuration”.

UNIX Configuration

Concerning UNIX printing information, please visit our Web site or consult your authorized reseller.
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1. Quick Install

You can easily install the software from the CD-ROM enclosed with the printer.

When [Quick Install] is clicked, the RPCS and PCL 5c printer drivers are installed in the computer al-

lowing the printer to be used by the computer.

In the case of TCP/IP, the software, SmartDeviceMonitor for Client, is also installed.

Limitation

❒ The OS requirements for the software are as indicated below.

• Windows 95/98/Me/2000/XP, Windows Server 2003 or Windows NT 4.0

❒ The following requirements must be satisfied in the case of TCP/IP.

• The printer and network must be connected with an ethernet cable.

• A TCP/IP protocol must be set.

• IP address must be set for the printer and the computer.

Quick Install

Limitation

❒ If your system is Windows 2000/Windows XP/Server 2003 or Windows NT 4.0, installing a printer

driver by Auto Run requires Administrators permission. When you install a printer driver by Auto

Run, log on using an account that has Administrators permission.

Note

❒ Auto Run might not automatically work with certain OS settings. In this case, launch “Setup.exe” lo-

cated on the CD-ROM root directory.

AAAA Close all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.
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CCCC Select a language to change the interface language, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), En-

glish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Ned-

erlands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),

Svenska (Swedish)

Default interface language is English.

DDDD Select [Quick Install].

The software license agreement appears in the [License Agreement] dialog box.

EEEE After reading through all of the contents, click [I accept the agreement] to agree with the license

agreement, and then click [Next].

FFFF Click to select a model name you want to use when the “Select Printer” dialog box appears.

Note

❒ For a network connection with TCP/IP, select the printer whose IP address is displayed in [Con-

nect To].

❒ For parallel connection, select the printer whose printer port is displayed in [Connect To].

GGGG Click [Install].

HHHH Follow the instructions on the screen.

Note

❒ During installation in Windows 2000, the [Digital Signature Not Found] dialog box may appear. In

this case, click [Yes] to continue the installation.

❒ During installation in Windows XP/Server 2003, the [Hardware Installation] dialog box may appear.

In this case, click [Continue Anyway] to continue the installation.

A message prompting you to restart your computer may appear. To complete the installation, restart

your computer.
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2. Windows 95/98/Me Configuration

Printing with a Print Server

Printing with a Windows 2000/XP, Windows Server 2003, or Windows NT 4.0 
Print Server

This section describes the procedures for setting up a client on a network that uses Windows 2000/XP,

Windows Server 2003, Windows NT 4.0 as a print server.

To print from Windows 95/98/Me, you must install the printer driver and change the printer port to the

print server.

Windows 2000/XP
Windows Server 2003
Windows NT 4.0
Print Server
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Installing the PCL 5c or RPCS Printer Driver

Preparation

To use the print server, install the printer driver by selecting “Network printer server”, and then select

the Windows 2000/XP, Windows Server 2003, or Windows NT 4.0 shared printer. For more infor-

mation about how to install and setting, see Administrator Reference.

This section assumes that the client has already been configured to communicate with a Windows

2000/XP, Windows Server 2003, or Windows NT 4.0 print server. Do not begin the following proce-

dure until the client has been set up and configured correctly.

Limitation

❒ If you print with a print server connected to the machine using the SmartDeviceMonitor port, Recov-

ery Printing and Parallel Printing cannot be used from the client.

❒ If you print with a Windows XP or Windows Server 2003 print server, notification functions of Smart-

DeviceMonitor may not be used with the client. 

AAAA Close all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

Important

❒ Never have two versions of the same printer driver installed on your system at the same time.

When upgrading to a new version of the printer driver, delete the old version, and then install the

new one.

Note

❒ Auto Run might not automatically work with certain OS settings. In this case, launch “Setup.exe”

located on the CD-ROM root directory.
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CCCC Select a language to change the interface language, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), En-

glish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Ned-

erlands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),

Svenska (Swedish)

DDDD Select [PCL/RPCS Printer Drivers].

EEEE The software license agreement appears in the [License Agreement] dialog box.

After reading through all of the contents, click [I accept the agreement] to agree with the license

agreement, and then click [Next].

FFFF Select a printer drivers you want to use when the “Printer Program” dialog box appears.

You can select more than one printer driver.

GGGG Check [Printer Name] to select the model(s) of printer you want to use.

To change the printer name, change it in the [Change settings for 'Printer Name'] box.

HHHH Double-click the printer name to display the printer settings.

Note

❒ The details shown for [Comment:], [Driver:], and [Port:] vary depending on the operating system

being used, the model of printer selected, and the port being used.

IIII Select [Port:], and then click [Add].

JJJJ Select [Network Printer], and then click [OK].

KKKK Double-click the computer name you want to use as a print server in the “Browse for Printer”

window.

LLLL Select the printer you want to use, and then click [OK].
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MMMM Make sure the location for the selected printer is shown after [Port:].

NNNN Configure the User Code and default printer as necessary.

❖❖❖❖ User Code
The procedure to specify the “User Code” may differ depending on the printer language.

• RPCS

You can specify the “User Code” when installing the printer driver. You cannot register or

edit the “User Code” from the Printer Driver dialog box. To change the “User Code”, you

must uninstall the printer driver, and then register the new “User Code” during the re-install

process.

• PCL 5c

You can specify the “User Code” with the Printer Driver Properties after installing the printer

driver. See printer driver's Help.

❖❖❖❖ Default Printer
Check [Default Printer] to set the printer as the default printer.

OOOO Click [Continue] to start printer driver installation.

PPPP When the [Select Program] dialog box appears, click [Finish].

QQQQ When the installation completion dialog box appears, click [Finish].

RRRR Set up the options.

Note

❒ You must set up the options when the bidirectional transmission is disabled. For more informa-

tion about the status of the bidirectional transmission, see p.55 “Bidirectional transmission”.

Reference

For more information about option settings, see p.54 “Setting Up Options”.
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Installing the PostScript Printer Driver

AAAA Close all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

Important

❒ Never have two versions of the same printer driver installed on your system at the same time.

When upgrading to a new version of the printer driver, delete the old version, and then install the

new one.

Note

❒ Auto Run might not automatically work with certain OS settings. In this case, launch “Setup.exe”

located on the CD-ROM root directory.

CCCC Select a language to change the interface language, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), En-

glish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Ned-

erlands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),

Svenska (Swedish)

Note

❒ The printer driver with the selected language will be installed. The printer driver will be installed

in English if you select the following languages: Portugues, Suomi

DDDD Click [PostScript 3 Printer Driver].

“Add Printer Wizard” starts.
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EEEE Click [Next].

FFFF Click [Network Printer], and then click [Next].

GGGG Click [Browse].

HHHH Double-click the computer name you want to use as a print server in the “Browse for Printer”

window.

IIII Select the printer you want to use, and then click [OK].

JJJJ After confirming that the location for the selected printer shown, click [Next].

KKKK Change the name of the printer if you want, and then click [Next].

Configure the default printer as necessary. Check [Yes] to set the printer as the default printer.

LLLL Select whether or not you want to print a test page, and then click [Finish].

The installation is complete.

Note

❒ You can specify the “User Code” with the Printer Driver Properties after installing the printer driver.

See printer driver's Help.

Reference

For more information about option settings, see p.54 “Setting Up Options”.

MMMM Restart the computer.
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Printing without Using a Print Server

Preparation

To use a printer connected to the Ethernet interface or IEEE 802.11b (Wireless LAN) interface, se-

lect “SmartDeviceMonitor” when installing the printer driver.

Configuring the Protocols

Configuring TCP/IP and IPP for Printing

Follow these instructions to configure the printer and Windows 95/98/Me to use the TCP/IP protocol

and IPP.

❖❖❖❖ Configuring the printer
Configure the printer to use the TCP/IP protocol.

• Confirm that the TCP/IP protocol is set to be active. (The factory default is active.)

• Assign an IP address and make other settings required for using the TCP/IP protocol.

Reference

For more information about how to make the above settings, see “Configuring the printer for the

Network”, Administrator Reference.

If DHCP is used to assign IP addresses, see “Using DHCP”, Administrator Reference.
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Note

❒ After setting the IP address, use the ping command to confirm that it has been set correctly.

A Windows 95/98

Click [Start], point to [Programs], and then click [MS-DOS Prompt].

B Windows Me

Click [Start], point to [Programs], point to [Accessories], and then click [MS-DOS Prompt].

C Type the following: (Example IP address is 192.168.15.16)

C:> ping 192.168.15.16

If the address has been configured correctly, the following message appears.

Reply from 192.168.15.16 : bytes=32 time<10ms TTL=32

If the address has been configured incorrectly, the following message appears.

Request timed out.

❖❖❖❖ Configuring a Windows 95/98/Me computer
Follow these steps to configure a Windows 95/98/Me computer to use the TCP/IP protocol.

A Open [Control Panel] and double-click the [Network] icon. Confirm that “TCP/IP” is listed in the

[The following network components are installed:] box under the [Configuration] tab.

Note

❒ If the TCP/IP protocol is not installed, click [Add] under the [Configuration] tab and install it. For

more information about installing the TCP/IP protocol, see Windows 95/98/Me Help.

B Configure the TCP/IP protocol with the appropriate IP address, subnet mask and other settings.

Confirm that the settings are correct with the network administrator.
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Configuring NetBEUI for Printing

Follow these instructions to configure the printer and Windows 95/98/Me to use the NetBEUI protocol.

Limitation

❒ To use NetBEUI, use the SmartDeviceMonitor for Client port.

❖❖❖❖ Configuring the printer
Enable SMB to print using NetBEUI (The default is active).

• Confirm that the NetBEUI protocol is set to be active. (The default is active.)

Reference

For more information about how to make the above settings, see “Configuring the printer for the

Network”, Administrator Reference.

❖❖❖❖ Configuring a Windows 95/98/Me computer
Install the NetBEUI protocol on the Windows 95/98/Me computer and set it as the default protocol.

A Open [Control Panel] and double-click the [Network] icon. Confirm that “NetBEUI” is listed in

the [The following network components are installed:] box under the [Configuration] tab.

Note

❒ If the NetBEUI protocol is not installed, click [Add] under the [Configuration] tab and install it.

For more information about installing the NetBEUI protocol, see Windows 95/98/Me Help.

❒ If “NetBEUI ->Dial-Up Adaptor” is listed in the [The following network components are installed:]

box, select it, and then click [Remove] to remove the binding.

B Set the NetBEUI protocol as the default protocol. Click the [Configuration] tab, select “Net-

BEUI” in the [The following network components are installed:] box, and then click [Properties].

C Click the [Advanced] tab, select [Set this protocol to be the default protocol], and then click [OK].

D Click [OK] to close the [Network] dialog box.

E When the message to restart appears, click [Yes].
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Installing Software

Preparation

If you are not using the print server, install SmartDeviceMonitor for Client, and then install the printer

driver by selecting “SmartDeviceMonitor for Client”. This enables peer-to-peer network printing with

the TCP/IP, NetBEUI, or IPP protocol.

Installing SmartDeviceMonitor for Client

AAAA Close all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

Important

❒ Never have two versions of the same printer driver installed on your system at the same time.

When upgrading to a new version of the printer driver, delete the old version, and then install the

new one.

Note

❒ Auto Run might not automatically work with certain OS settings. In this case, launch “Setup.exe”

located on the CD-ROM root directory.

CCCC Select a language to change the interface language, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), En-

glish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Ned-

erlands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),

Svenska (Swedish)
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DDDD Click [SmartDeviceMonitor for Client / Admin].

EEEE Click to select [SmartDeviceMonitor for Client], and then click [Next >].

FFFF Follow the instructions on the screen.

Note

❒ If you are required to restart the computer after the installation of SmartDeviceMonitor for Client,

restart the computer and continue with necessary configurations.
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Installing the PCL 5c or RPCS Printer Driver

AAAA Close all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

Important

❒ Never have two versions of the same printer driver installed on your system at the same time.

When upgrading to a new version of the printer driver, delete the old version, and then install the

new one.

Note

❒ Auto Run might not automatically work with certain OS settings. In this case, launch “Setup.exe”

located on the CD-ROM root directory.

CCCC Select a language to change the interface language, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), En-

glish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Ned-

erlands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),

Svenska (Swedish)

DDDD Select [PCL/RPCS Printer Drivers].

EEEE The software license agreement appears in the [License Agreement] dialog box.

After reading through all of the contents, click [I accept the agreement] to agree with the license

agreement, and then click [Next].

FFFF Select a printer drivers you want to use when the “Printer Program” dialog box appears.

You can select more than one printer driver.
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GGGG Check [Printer Name] to select the model(s) of printer you want to use.

To change the printer name, change it in the [Change settings for 'Printer Name'] box.

HHHH Double-click the printer name to display the printer settings.

Note

❒ The details shown for [Comment:], [Driver:], and [Port:] vary depending on the operating system

being used, the model of printer selected, and the port being used.

IIII Select SmartDeviceMonitor.

SmartDeviceMonitor

A Select [Port:], and then click [Add].

B Select [SmartDeviceMonitor], and then click [OK].

C Select a printer you want to use.

❖❖❖❖ TCP/IP

A Click [TCP/IP], and then click [Search].
Available printers will be listed.

B Click the printer you want to use, and then click [OK].

Note

❒ Printers that respond to an IP broadcast from the computer will be displayed. To print to a

printer not listed here, click [Specify Address], and then type the IP address or host name.

❒ You cannot add an address partially similar to that already used. For example, when

“192.168.0.2” is already used, “192.168.0.2xx” cannot be used. Similarly, when

“192.168.0.20” is already used, “192.168.0.2” cannot be used. 
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❖❖❖❖ NetBEUI

A Click [NetBEUI], and then click [Search].
A list of printers that can be used by the NetBEUI protocol appears.

B Click the printer you want to use, and then click [OK].

Note

❒ Printers that respond to a broadcast from the computer will be displayed. To print to a

printer not listed here, click [Specify Address], and then type the NetBEUI address. Confirm

the NetBEUI address on the network is on the configuration page. For more information

about printing the configuration page, see “Printing a Configuration Page”, Administrator

Reference. NetBEUI address appears as “\RNPxxxxxxx” on the configuration page. Type

the printer's network path name in the form of “%%Computer name\Share name”. Do not

type “\” as head characters but “%%”.

❒ You cannot print to printers beyond routers.

❖❖❖❖ IPP

A Click [IPP].
The IPP setting dialog box appears.

B To specify the IP address of the printer, type “http://printer's-ip-address/printer” in the

[Printer URL] field.

Note

❒ If this machine has the optional network data protection unit installed and server au-

thentication is issued, enter “https://printer's-ip-address/printer” (Internet Explorer 5.01

or a later version must be installed).

(Example IP address: 192.168.15.16)

http://192.168.15.16/printer

https://192.168.15.16/printer



Operating Instructions Client Reference

36

C As necessary, type the names to distinguish the printer in [IPP Port Name]. Type a different

name from those of any existing port name.

If you omit this, the address typed in [Printer URL] will be set as the IPP port name.

D If a proxy server and IPP user name are used, click [Detailed Settings], and then configure

the necessary settings.

Note

❒ For more information about these settings, see SmartDeviceMonitor for Client Help.

E Click [OK].

JJJJ Make sure the location for the selected printer is shown after [Port:].

KKKK Configure the User Code and default printer as necessary.

❖❖❖❖ User Code
The procedure to specify the “User Code” may differ depending on the printer language.

• RPCS

You can specify the “User Code” when installing the printer driver. You cannot register or

edit the “User Code” from the Printer Driver dialog box. To change the “User Code”, you

must uninstall the printer driver, and then register the new “User Code” during the re-install

process.

• PCL 5c

You can specify the “User Code” with the Printer Driver Properties after installing the printer

driver. See printer driver's Help.

❖❖❖❖ Default Printer
Check [Default Printer] to set the printer as the default printer.

LLLL Click [Continue] to start printer driver installation.
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MMMM When the [Select Program] dialog box appears, click [Finish].

NNNN When the installation completion dialog box appears, click [Finish].

OOOO Set up the options.

Note

❒ You must set up the options when the bidirectional transmission is disabled. For more informa-

tion about the status of the bidirectional transmission, see p.55 “Bidirectional transmission”.

Reference

For more information about option settings, see p.54 “Setting Up Options”.
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Installing the PostScript Printer Driver

AAAA Close all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

Important

❒ Never have two versions of the same printer driver installed on your system at the same time.

When upgrading to a new version of the printer driver, delete the old version, and then install the

new one.

Note

❒ Auto Run might not automatically work with certain OS settings. In this case, launch “Setup.exe”

located on the CD-ROM root directory.

CCCC Select a language to change the interface language, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), En-

glish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Ned-

erlands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),

Svenska (Swedish)

Note

❒ The printer driver with the selected language will be installed. The printer driver will be installed

in English if you select the following languages: Portugues, Suomi

DDDD Click [PostScript 3 Printer Driver].

“Add Printer Wizard” starts.
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EEEE Click [Next].

FFFF Click [Local Printer], and then click [Next].

A dialog box for selecting the printer manufacturer and model name appears.

GGGG Click to select the name of the printer whose driver you want to install, and then click [Next].

HHHH In the [Available ports:] box, click to select [Printer Port], and then click [Next].

IIII Change the name of the printer if you want, and then click [Next].

Configure the default printer as necessary. Check [Yes] to set the printer as the default printer.

JJJJ Select whether or not you want to print a test page, and then click [Finish].

KKKK Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

LLLL Click the icon of the printer you want to use. On the [File] menu, click [Properties].

MMMM Select [Details], and then click [Add Port…].

NNNN In the [Other] box, click to select [SmartDeviceMonitor], and then click [OK].

OOOO Select a printer you want to use.
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TCP/IP

A Click [TCP/IP], and then click [Search].

Available printers will be listed.

B Click the printer you want to use, and then click [OK].

Note

❒ Printers that respond to an IP broadcast from the computer will be displayed. To print to a

printer not listed here, click [Specify Address], and then type the IP address or host name.

❒ You cannot add an address partially similar to that already used. For example, when

“192.168.0.2” is already used, “192.168.0.2xx” cannot be used. Similarly, when

“192.168.0.20” is already used, “192.168.0.2” cannot be used. 

NetBEUI

A Click [NetBEUI], and then click [Search].

A list of printers that can be used by the NetBEUI protocol appears.

B Click the printer you want to use, and then click [OK].

Note

❒ Printers that respond to a broadcast from the computer will be displayed. To print to a printer

not listed here, click [Specify Address], and then type the NetBEUI address. Confirm the Net-

BEUI address on the network is on the configuration page. For more information about print-

ing the configuration page, see “Printing a Configuration Page”, Administrator Reference.

NetBEUI address appears as “\RNPxxxxxxx” on the configuration page. Type the printer's

network path name in the form of “%%Computer name\Share name”. Do not type “\” as head

characters but “%%”.

❒ You cannot print to printers beyond routers.
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IPP

A Click [IPP].

The IPP setting dialog box appears.

B In [Printer URL], type “http://(printer's IP address)/printer” as the printer's IP address.

Note

❒ If this machine has the optional network data protection unit installed and server authentica-

tion is issued, enter “https://printer's-ip-address/printer” (Internet Explorer 5.01 or a later ver-

sion must be installed).

(Example IP address: 192.168.15.16)

http://192.168.15.16/printer

https://192.168.15.16/printer

C As necessary, type the names to distinguish the printer in [IPP Port Name]. Type a different

name from those of any existing port name.

If you omit this, the address typed in [Printer URL] will be set as the IPP port name.

D If a proxy server and IPP user name are used, click [Detailed Settings], and then configure

the necessary settings.

Note

❒ For more information about these settings, see SmartDeviceMonitor for Client Help.

E Click [OK].

PPPP Click [OK].
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QQQQ Confirm that the selected port is highlighted in [Printer to the following port], and then click [OK].

Note

❒ You can specify the “User Code” with the Printer Driver Properties after installing the printer driver.

See printer driver's Help.

Reference

For more information about option settings, see p.54 “Setting Up Options”.

RRRR Restart the computer.
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Changing Port Settings

Follow the steps to change SmartDeviceMonitor for Client settings, such as the proxy server settings

or IPP URL.

Note

❒  There are no settings for the NetBEUI protocol.

AAAA From the [Printers] window, click the icon of the printer you want to use. On the [File] menu,

click [Properties].

BBBB Click the [Details] tab, and then click [Port Settings...].

The [Port Settings] dialog box appears.

• For TCP/IP protocol, you can configure Timeout Settings.

Note

❒ If you cannot set items on the [Recovery/Parallel Printing] tab, follow the procedure below.

A Click [Cancel] to close the [Port Settings] dialog box.

B Start SmartDeviceMonitor for Client, and then right-click the SmartDeviceMonitor for Cli-

ent icon on the taskbar.

C Click [Extended Features Settings], and then select the [Set Recovery/Parallel Printing for each

port] check box.

D Click [OK] to close the [Extended Features Settings] dialog box.

• For IPP, you can configure User Settings, Proxy Settings and Timeout Settings.

Note

❒ For more information about these settings, see SmartDeviceMonitor for Client Help.
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Printing with Parallel Connection

To use a printer connected to the parallel interface, select “LPT1:” when installing the printer driver.

Installing the PCL 5c or RPCS Printer Driver

AAAA Close all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

Important

❒ Never have two versions of the same printer driver installed on your system at the same time.

When upgrading to a new version of the printer driver, delete the old version, and then install the

new one.

Note

❒ Auto Run might not automatically work with certain OS settings. In this case, launch “Setup.exe”

located on the CD-ROM root directory.

CCCC Select a language to change the interface language, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), En-

glish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Ned-

erlands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),

Svenska (Swedish)

DDDD Select [PCL/RPCS Printer Drivers].
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EEEE The software license agreement appears in the [License Agreement] dialog box.

After reading through all of the contents, click [I accept the agreement] to agree with the license

agreement, and then click [Next].

FFFF Select a printer drivers you want to use when the “Printer Program” dialog box appears.

You can select more than one printer driver.

GGGG Check [Printer Name] to select the model(s) of printer you want to use.

To change the printer name, change it in the [Change settings for 'Printer Name'] box.

HHHH Double-click the printer name to display the printer settings.

Note

❒ The details shown for [Comment:], [Driver:], and [Port:] vary depending on the operating system

being used, the model of printer selected, and the port being used.

IIII After confirming [Port:] that the location for [LPT1:] shown.

JJJJ Configure the User Code and default printer as necessary.

❖❖❖❖ User Code
The procedure to specify the “User Code” may differ depending on the printer language.

• RPCS

You can specify the “User Code” when installing the printer driver. You cannot register or edit

the “User Code” from the Printer Driver dialog box. To change the “User Code”, you must un-

install the printer driver, and then register the new “User Code” during the re-install process.

• PCL 5c/PostScript 3

You can specify the “User Code” with the Printer Driver Properties after installing the printer

driver. See printer driver's Help.

❖❖❖❖ Default Printer
Check [Default Printer] to set the printer as the default printer.
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KKKK Click [Continue] to start printer driver installation.

LLLL When the [Select Program] dialog box appears, click [Finish].

MMMM When the installation completion dialog box appears, click [Finish].

NNNN Set up the options.

Note

❒ You must set up the options when the bidirectional transmission is disabled. For more informa-

tion about the status of the bidirectional transmission, see p.55 “Bidirectional transmission”.

Reference

For more information about option settings, see p.54 “Setting Up Options”.
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Installing the PostScript Printer Driver

AAAA Close all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

Important

❒ Never have two versions of the same printer driver installed on your system at the same time.

When upgrading to a new version of the printer driver, delete the old version, and then install the

new one.

Note

❒ Auto Run might not automatically work with certain OS settings. In this case, launch “Setup.exe”

located on the CD-ROM root directory.

CCCC Select a language to change the interface language, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), En-

glish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Ned-

erlands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),

Svenska (Swedish)

Note

❒ The printer driver with the selected language will be installed. The printer driver will be installed

in English if you select the following languages: Portugues, Suomi

DDDD Click [PostScript 3 Printer Driver].

“Add Printer Wizard” starts.
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EEEE Click [Next].

FFFF Click [Local Printer], and then click [Next].

A dialog box for selecting the printer manufacturer and model name appears.

GGGG Click to select the name of the printer whose driver you want to install, and then click [Next].

HHHH In the [Available ports:] box, click to select [Printer Port], and then click [Next].

IIII Change the name of the printer if you want, and then click [Next].

Configure the default printer as necessary. Check [Yes] to set the printer as the default printer.

JJJJ Select whether or not you want to print a test page, and then click [Finish].

Reference

For more information about option settings, see p.54 “Setting Up Options”.

KKKK Restart the computer.
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Installing the Printer Driver Using USB

This section describes basic instructions for installing the printer drivers using USB. The printer drivers

can be installed from the provided CD-ROM.

Preparation

Installation is not possible under Windows 95/98. Upgrade to Windows 98 SE/Me.

Before installation, check the status of the computer to which the USB cable is connected is as de-

scribed below.

• Only the operating system should be running.

• Printing should not be in progress.

The procedure below takes Windows 98 as an example. The procedure for Windows Me may be slightly

different.
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Windows 98 SE/Me-Installing the Printer Driver Using USB

When the USB cable is used for the first time, the “plug and play” function starts and [New Hardware
Found], [Device Driver Wizard] or [Add New Hardware Wizard] dialog box appears depending on the system

used.

If the printer driver is already installed, the “plug and play” is displayed, and the printer with its port

directed to the USB cable is added to the “Printers” folder.

AAAA Click [Next>].

BBBB Select [Search for the best driver for your device. {Recommended}.], and then click [Next>].

CCCC Check [Specify a location:], and then click [Browse...].

The [Browse for Folder] dialog box appears.

DDDD Insert the CD-ROM provided into the CD-ROM drive.

Note

❒ When Auto Run starts, click [Exit].

❒ If you want to inactivate Auto Run, press {{{{Shift}}}} key when inserting the CD-ROM into the drive

and keep it pressed until the computer completes transmission to the drive.

EEEE Select the drive where the USB Printing Support is located according to the operating system

used, and then click [Next>].

If the CD-ROM drive is D, the folder will be “D:\Drivers\USBPRINT\WIN98ME”.
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FFFF Confirm the printer driver location, and then click [Next>].

“USB Printing Support” will be installed.

GGGG Click [Finish].

If the printer driver is already installed, the Plug and Play is activated, and an icon of the printer for

which [USB001] is specified for [Printing Port] is created in the [Printer] window.

Note

❒ The number after “USB” varies depending on the number of printers connected.

❒ It is not necessary to reinstall USB Printing Support when connecting a different printer with the

USB interface after USB Printing Support is installed.
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Installing the Printer Driver (USB Connection)

If the printer driver is not installed, install it by following the instructions on the printer's Plug and Play

menu after installing USB Printing Support.

Install the printer driver from the CD-ROM provided with the printer.

AAAA Click [Next>].

BBBB Select [Search for the best driver for your device. {Recommended}.], and then click [Next>].

CCCC Check [Specify a location:], and then click [Browse...].

The [Browse for Folder] dialog box appears.

DDDD Insert the CD-ROM provided into the CD-ROM drive.

Note

❒ When Auto Run starts, click [Exit].

❒ If you want to inactivate Auto Run, press {{{{Shift}}}} key when inserting the CD-ROM into the drive

and keep it pressed until the computer completes transmission to the drive.

EEEE Select the drive where the printer driver is located according to the operating system used, and

then click [Next>].

If the CD-ROM drive is D, the locations where each printer driver is stored are as indicated below.

• RPCS

D:\DRIVES\RPCS\WIN98_ME\(Language)\DISK1

• PCL 5c

D:\DRIVES\PCL5c\WIN98_ME\(Language)\DISK1

• PostScript 3

D:\DRIVES\PS3\WIN98_ME\(Language)\DISK1
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FFFF Confirm the printer driver location, and then click [Next>].

The [Add Printer Wizard] dialog box appears.

GGGG Click [Finish].

The printer driver is installed. If installation is successful, an icon of the printer for which [USB001]
is specified for [Printing Port] is created in the [Printer] window.

Note

❒ The number after “USB” varies depending on the number of printers connected.
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Setting Up Options

You must set up the options when the bidirectional transmission is disabled.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click the icon of the printer you want to use.

CCCC On the [File] menu, click [Properties].

DDDD Click the [Accessories] tab.

Note

❒ If you use the RPCS printer driver, Click [Printer Configuration...] under the Print Settings tab.

EEEE Select options you have installed from the [Option] group. And make any settings you require.

FFFF Click [OK].
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----Bidirectional transmission

When bidirectional transmission is enabled, the information about the paper size and feed direction set-

ting is automatically sent to the printer by a computer. You can also confirm the printer status from your

computer.

• Bidirectional transmission is supported by Windows 95/98/Me/2000/XP, Windows Server 2003,

and Windows NT 4.0.

• If you use the RPCS printer driver and bidirectional transmission is enabled, on Windows 95/98/Me,

the unavailable functions are shaded in the [Change Accessories] dialog box of the printer proper-

ties. The [Change Accessories] dialog box is displayed by clicking the [Change Accessories...] but-

ton under the [Printer Configuration] tab.

Note

❒ The RPCS printer driver supports bidirectional transmission and updates the printer status automatically.

❒ The PCL 5c printer driver supports bidirectional transmission, you can update the printer status

manually.

❒ The PostScript 3 printer driver does not support bidirectional transmission.

To support bidirectional transmission, the following conditions are required:
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❖❖❖❖ When connecting with a parallel cable

• The computer must support bidirectional transmission.

• The printer must be set to bidirectional transmission.

• The Interface cable must support bidirectional transmission.

• The machine must be connected to the computer using the standard parallel cable and parallel

connector.

• Under Windows 95/98/Me, [Enable bidirectional support for this printer] must be selected in

[Spool Settings…] on the [Details] tab with RPCS printer driver.

❖❖❖❖ When connecting with the network

• The printer must be set to bidirectional transmission.

• SmartDeviceMonitor for Client included on the CD-ROM must be installed, and the TCP/IP pro-

tocol must be used.

• Under Windows 95/98/Me, [Enable bidirectional support for this printer] must be selected in

[Spool Settings…] on the [Details] tab with RPCS printer driver.

❖❖❖❖ When connecting with USB
The printer must be connected to the USB connector of a computer using the USB interface cable.
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3. Windows 2000 Configuration

Printing with a Print Server

Printing with a Windows 2000/XP, Windows Server 2003, or Windows NT 4.0 
Print Server

This section describes the procedures for setting up a client in a network that uses Windows 2000/XP,

Windows Server 2003, Windows NT 4.0.

To print from Windows 2000, you must install the printer driver and change the printer port to the print

server.

Windows 2000/XP
Windows Server 2003
Windows NT 4.0
Print Server
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Installing the PCL 5c or RPCS Printer Driver

Preparation

To use the print server, install the printer driver by selecting “Network printer server”, and then select

the Windows 2000/XP, Windows Server 2003, or Windows NT 4.0 shared printer. For more infor-

mation about how to install and setting, see Administrator Reference.

This section assumes that the client has already been configured to communicate with a Windows

2000/XP, Windows Server 2003, or Windows NT 4.0 print server. Do not begin the following proce-

dure until the client has been set up and configured correctly.

Limitation

❒ If you print with a print server connected to the machine using the SmartDeviceMonitor port, Recov-

ery Printing and Parallel Printing cannot be used from the client.

❒ If you print with a Windows XP or Windows Server 2003 print server, notification functions of Smart-

DeviceMonitor may not be used with the client. 

Note

❒ If you print with a Windows NT 4.0 print server, install the printer driver before you connect the print

server to the machine.
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AAAA Close all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

Important

❒ Never have two versions of the same printer driver installed on your system at the same time.

When upgrading to a new version of the printer driver, delete the old version, and then install the

new one.

Note

❒ Auto Run might not automatically work with certain OS settings. In this case, launch “Setup.exe”

located on the CD-ROM root directory.

CCCC Select a language to change the interface language, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), En-

glish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Ned-

erlands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),

Svenska (Swedish)

DDDD Select [PCL/RPCS Printer Drivers].

EEEE The software license agreement appears in the [License Agreement] dialog box.

After reading through all of the contents, click [I accept the agreement] to agree with the license

agreement, and then click [Next].

FFFF Select a printer drivers you want to use when the “Printer Program” dialog box appears.

You can select more than one printer driver.

GGGG Check [Printer Name] to select the model(s) of printer you want to use.

To change the printer name, change it in the [Change settings for 'Printer Name'] box.
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HHHH Double-click the printer name to display the printer settings.

Note

❒ The details shown for [Comment:], [Driver:], and [Port:] vary depending on the operating system

being used, the model of printer selected, and the port being used.

IIII Select [Port:], and then click [Add].

JJJJ Select [Network Printer], and then click [OK].

KKKK Double-click the computer name you want to use as a print server in the “Browse for Printer”

window.

LLLL Select the printer you want to use, and then click [OK].

MMMM Make sure the location for the selected printer is shown after [Port:].

NNNN Configure the User Code and default printer as necessary.

❖❖❖❖ User Code
When using RPCS, you can specify the “User Code” with the Printer Driver Properties after in-

stalling the printer driver. See printer driver's Help.

❖❖❖❖ Default Printer
Check [Default Printer] to set the printer as the default printer.

OOOO Click [Continue] to start printer driver installation.

Note

❒ During installation, the [Digital Signature Not Found] dialog box may appear. In this case, click [Yes]

to continue the installation.
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PPPP When the [Select Program] dialog box appears, click [Finish].

QQQQ When the installation completion dialog box appears, click [Finish].

RRRR Set up the options.

Note

❒ You must set up the options when the bidirectional transmission is disabled. For more informa-

tion about the status of the bidirectional transmission, see p.89 “Bidirectional transmission”.

Reference

For more information about option settings, see p.88 “Setting Up Options”.
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Installing the PostScript Printer Driver

AAAA Close all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

Important

❒ Never have two versions of the same printer driver installed on your system at the same time.

When upgrading to a new version of the printer driver, delete the old version, and then install the

new one.

Note

❒ Auto Run might not automatically work with certain OS settings. In this case, launch “Setup.exe”

located on the CD-ROM root directory.

CCCC Select a language to change the interface language, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), En-

glish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Ned-

erlands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),

Svenska (Swedish)

Note

❒ The printer driver with the selected language will be installed. The printer driver will be installed

in English if you select the following languages: Portugues, Suomi

DDDD Click [PostScript 3 Printer Driver].

“Add Printer Wizard” starts.
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EEEE Click [Next].

FFFF Click [Network printer], and then click [Next].

GGGG Click [Next].

HHHH Double-click the computer name you want to use as a print server in the “Shared printers”

window.

IIII Select the printer you want to use, and then click [Next].

JJJJ Start printer driver installation.

KKKK Click [Next>].

Configure the default printer as necessary. Check [Yes] to set the printer as the default printer.

LLLL Click [Finish].

The installation is complete.

Note

❒ You can specify the “User Code” with the Printer Driver Properties after installing the printer driver.

See printer driver's Help.

Reference

For more information about option settings, see p.88 “Setting Up Options”.

MMMM Restart the computer.
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Printing without Using a Print Server

Preparation

To use a printer connected to the Ethernet interface or IEEE 802.11b (Wireless LAN) interface, se-

lect “SmartDeviceMonitor”, “Standard TCP/IP Port”, “LPR Port” when installing the printer driver.

• SmartDeviceMonitor See p.65 “Configuring the Protocols” and p.68 “Installing Software” and p.69

“Installing the PCL 5c or RPCS Printer Driver” or p.74 “Installing the PostScript Printer Driver”.

• Standard TCP/IP Port, LPR Port See p.65 “Configuring the Protocols” and p.69 “Installing the

PCL 5c or RPCS Printer Driver” or p.74 “Installing the PostScript Printer Driver”.

Note

❒ If you want to use “LPR Port”, “Print Services for UNIX” must be installed.
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Configuring the Protocols

Configuring TCP/IP and IPP for Printing

Follow these instructions to configure the printer and Windows 2000 to use the TCP/IP protocol and IPP.

❖❖❖❖ Configuring the printer
Configure the printer to use the TCP/IP protocol.

• Confirm that the TCP/IP protocol is set to be active. (The factory default is active.)

• Assign an IP address and make other settings required for using the TCP/IP protocol.

Reference

For more information about how to make the above settings, see “Configuring the printer for the

Network”, Administrator Reference.

If DHCP is used to assign IP addresses, see “Using DHCP”, Administrator Reference.

Note

❒ After setting the IP address, use the ping command to confirm that it has been set correctly.

A Click [Start], point to [Programs], point to [Accessories], and then click [Command Prompt].

B Type the following: (Example IP address is 192.168.15.16)

C:> ping 192.168.15.16

If the address has been configured correctly, the following message appears.

Reply from 192.168.15.16 : bytes=32 time<10ms TTL=32

If the address has been configured incorrectly, the following message appears.

Request timed out.
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❖❖❖❖ Configuring a Windows 2000 computer
Follow these steps to configure a Windows 2000 computer to use the TCP/IP protocol.

A Click [Start] on the taskbar, point to [Settings], and then click [Network and Dial-up Connections].

B Click [Local Area Connection].

C On the [File] menu, click [Properties].

D Confirm that “Internet Protocol (TCP/IP)” is selected in the [Components checked are used by

this connection:] box on the [General] tab.

Note

❒ If the check box for TCP/IP protocol is not selected, select the box.

❒ If the TCP/IP protocol is not installed, click [Install...] on the [General] tab and install it. For more

information about installing the TCP/IP protocol, see Windows 2000 Help.

E Configure the TCP/IP protocols with the appropriate IP address, subnet mask and other settings.

Confirm that the settings are correct with the network administrator.
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Configuring NetBEUI for Printing

Follow these instructions to configure network interface board and Windows 2000 to use the NetBEUI

protocol.

Preparation

To use NetBEUI, use the SmartDeviceMonitor for Client port.

❖❖❖❖ Configuring the printer
Enable SMB to print using NetBEUI (The default is active).

Reference

For more information about how to make the above settings, see “Configuring the printer for the

Network”, Administrator Reference.

❖❖❖❖ Configuring a Windows 2000 computer
Follow these steps to configure a Windows 2000 computer to use the NetBEUI protocol.

A Click [Start] on the taskbar, point to [Settings], and then click [Network and Dial-up Connections].

B Click [Local Area Connection].

C On the [File] menu, click [Properties].

D Confirm that “NetBEUI Protocol” is selected in the [Components checked are used by this con-

nection:] box on the [General] tab.

Note

❒ If the check box of the NetBEUI protocol is not selected, select the box.

❒ If the NetBEUI protocol is not installed, click [Install...] on the [General] tab and install it. For

more information about installing the NetBEUI protocol, see Windows 2000 Help.
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Installing Software

Preparation

If you are not using the print server, install SmartDeviceMonitor for Client, and then install the printer

driver by selecting “SmartDeviceMonitor for Client”. This enables peer-to-peer network printing with

the TCP/IP, NetBEUI, or IPP protocol.

Installing SmartDeviceMonitor for Client

AAAA Close all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

Note

❒ Auto Run might not automatically work with certain OS settings. In this case, launch “Setup.exe”

located on the CD-ROM root directory.

CCCC Select a language to change the interface language, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), English (En-

glish), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Nederlands (Dutch),

Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish), Svenska (Swedish)

DDDD Click [SmartDeviceMonitor for Client / Admin].

EEEE Click to select [SmartDeviceMonitor for Client], and then click [Next >].

FFFF Follow the instructions on the screen.

Note

❒ If you are required to restart the computer after the installation of SmartDeviceMonitor for Client,

restart the computer and continue with necessary configurations.
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Installing the PCL 5c or RPCS Printer Driver

AAAA Close all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

Important

❒ Never have two versions of the same printer driver installed on your system at the same time.

When upgrading to a new version of the printer driver, delete the old version, and then install the

new one.

Note

❒ Auto Run might not automatically work with certain OS settings. In this case, launch “Setup.exe”

located on the CD-ROM root directory.

CCCC Select a language to change the interface language, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), En-

glish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Ned-

erlands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),

Svenska (Swedish)

DDDD Select [PCL/RPCS Printer Drivers].

EEEE The software license agreement appears in the [License Agreement] dialog box.

After reading through all of the contents, click [I accept the agreement] to agree with the license

agreement, and then click [Next].

FFFF Select a printer drivers you want to use when the “Printer Program” dialog box appears.

You can select more than one printer driver.
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GGGG Select the printer model(s) you want to use.

To change the printer name, change it in the [Change settings for 'Printer Name'] box.

HHHH Double-click the printer name to display the printer settings.

Note

❒ The details shown for [Comment:], [Driver:], and [Port:] vary depending on the operating system

being used, the model of printer selected, and the port being used.

IIII Click [Port:], and then select the port you want to use.

• SmartDeviceMonitor

• Standard TCP/IP Port

• LPR Port

SmartDeviceMonitor

A Click [Add Port...].

B Select [SmartDeviceMonitor], and then click [New Port...].

C Select a printer you want to use.

❖❖❖❖ TCP/IP

A Click [TCP/IP], and then click [Search].
Available printers will be listed.

B Click the printer you want to use, and then click [OK].

Note

❒ Printers that respond to an IP broadcast from the computer will be displayed. To print to a

printer not listed here, click [Specify Address], and then type the IP address or host name.

❒ You cannot add an address partially similar to that already used. For example, when

“192.168.0.2” is already used, “192.168.0.2xx” cannot be used. Similarly, when

“192.168.0.20” is already used, “192.168.0.2” cannot be used. 
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❖❖❖❖ NetBEUI

A Click [NetBEUI], and then click [Search].
A list of printers that can be used by the NetBEUI protocol appears.

B Click the printer you want to use, and then click [OK].

Note

❒ Printers that respond to a broadcast from the computer will be displayed. To print to a

printer not listed here, click [Specify Address], and then type the NetBEUI address. Confirm

the NetBEUI address on the network is on the configuration page. For more information

about printing the configuration page, see “Printing a Configuration Page”, Administrator

Reference. NetBEUI address appears as “\RNPxxxxxxx” on the configuration page. Type

the printer's network path name in the form of “%%Computer name\Share name”. Do not

type “\” as head characters but “%%”.

❒ You cannot print to printers beyond routers.

❖❖❖❖ IPP

A Click [IPP].
The IPP setting dialog box appears.

B To specify the IP address of the printer, type “http://printer's-ip-address/printer” in the

[Printer URL] field.

Note

❒ If this machine has the optional network data protection unit installed and server au-

thentication is issued, enter “https://printer's-ip-address/printer” (Internet Explorer 5.01

or a later version must be installed).

(Example IP address: 192.168.15.16)

http://192.168.15.16/printer

https://192.168.15.16/printer
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C As necessary, type the names to distinguish the printer in [IPP Port Name]. Type a different

name from those of any existing port name.

If you omit this, the address typed in [Printer URL] will be set as the IPP port name.

D If a proxy server and IPP user name are used, click [Detailed Settings], and then configure

the necessary settings.

Note

❒ For more information about these settings, see SmartDeviceMonitor for Client Help.

E Click [OK].

Standard TCP/IP Port

A Click [Add Port...].

B Select [Standard TCP/IP], and then click [New Port...].

C Click [Next] in the “Add Standard TCP/IP Printer Port Wizard” window.

D Type the printer name or IP address in the “Printer Name or IP Address” box.

E Click [Finish] in the “Add Standard TCP/IP Printer Port Wizard” window.
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LPR Port

A Click [Add Port...].

B Select [LPR Port], and then click [New Port...].

C Type the printer's IP address in the “Name or address of server providing lpd” box.

D Type “lp” in the “Name of printer or print queue on that server” box, and then click [OK].

JJJJ Make sure the location for the selected printer is shown after [Port:].

KKKK Configure the default printer as necessary.

❖❖❖❖ Default Printer
Check [Default Printer] to set the printer as the default printer.

LLLL Click [Continue] to start printer driver installation.

MMMM When the [Select Program] dialog box appears, click [Finish].

Note

❒ During installation, the [Digital Signature Not Found] dialog box may appear. In this case, click [Yes]

to continue the installation.

NNNN When the installation completion dialog box appears, click [Finish].

OOOO Set up the options.

Note

❒ You must set up the options when the bidirectional transmission is disabled. For more informa-

tion about the status of the bidirectional transmission, see p.89 “Bidirectional transmission”.

Reference

For more information about option settings, see p.88 “Setting Up Options”.
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Installing the PostScript Printer Driver

AAAA Close all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

Important

❒ Never have two versions of the same printer driver installed on your system at the same time.

When upgrading to a new version of the printer driver, delete the old version, and then install the

new one.

Note

❒ Auto Run might not automatically work with certain OS settings. In this case, launch “Setup.exe”

located on the CD-ROM root directory.

CCCC Select a language to change the interface language, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), En-

glish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Ned-

erlands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),

Svenska (Swedish)

Note

❒ The printer driver with the selected language will be installed. The printer driver will be installed

in English if you select the following languages: Portugues, Suomi

DDDD Click [PostScript 3 Printer Driver].

“Add Printer Wizard” starts.

EEEE Click [Next >].
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FFFF Select [Local printer], and then click [Next>].

GGGG Select the port you want to use.

• SmartDeviceMonitor

• Standard TCP/IP Port

• LPR Port

SmartDeviceMonitor

A Click [Add Port...].

B Select [SmartDeviceMonitor], and then click [Next >].

C Select a printer you want to use.

❖❖❖❖ TCP/IP

A Click [TCP/IP], and then click [Search].
Available printers will be listed.

B Click the printer you want to use, and then click [OK].

Note

❒ Printers that respond to an IP broadcast from the computer will be displayed. To print to a

printer not listed here, click [Specify Address], and then type the IP address or host name.

❒ You cannot add an address partially similar to that already used. For example, when

“192.168.0.2” is already used, “192.168.0.2xx” cannot be used. Similarly, when

“192.168.0.20” is already used, “192.168.0.2” cannot be used. 
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❖❖❖❖ NetBEUI

A Click [NetBEUI], and then click [Search].
A list of printers that can be used by the NetBEUI protocol appears.

B Click the printer you want to use, and then click [OK].

Note

❒ Printers that respond to a broadcast from the computer will be displayed. To print to a

printer not listed here, click [Specify Address], and then type the NetBEUI address. Confirm

the NetBEUI address on the network is on the configuration page. For more information

about printing the configuration page, see “Printing a Configuration Page”, Administrator

Reference. NetBEUI address appears as “\RNPxxxxxxx” on the configuration page. Type

the printer's network path name in the form of “%%Computer name\Share name”. Do not

type “\” as head characters but “%%”.

❒ You cannot print to printers beyond routers.

❖❖❖❖ IPP

A Click [IPP].
The IPP setting dialog box appears.

B To specify the IP address of the printer, type “http://printer's-ip-address/printer” in the

[Printer URL] field.

Note

❒ If this machine has the optional network data protection unit installed and server au-

thentication is issued, enter “https://printer's-ip-address/printer” (Internet Explorer 5.01

or a later version must be installed).

(Example IP address: 192.168.15.16)

http://192.168.15.16/printer

https://192.168.15.16/printer
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C As necessary, type the names to distinguish the printer in [IPP Port Name]. Type a different

name from those of any existing port name.

If you omit this, the address typed in [Printer URL] will be set as the IPP port name.

D If a proxy server and IPP user name are used, click [Detailed Settings], and then configure

the necessary settings.

Note

❒ For more information about these settings, see SmartDeviceMonitor

for Client Help.

E Click [OK].

Standard TCP/IP Port

A Click [Add Port...].

B Select [Standard TCP/IP], and then click [New Port...].

C Click [Next] in the “Add Standard TCP/IP Printer Port Wizard” window.

D Type the printer name or IP address in the “Printer Name or IP Address” box, and then

click [Next>].

E Click [Finish] in the “Add Standard TCP/IP Printer Port Wizard” window.
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LPR Port

A Click [Add Port...].

B Select [LPR Port], and then click [New Port...].

C Type the printer's IP address in the “Name or address of server providing lpd” box.

D Type “lp” in the “Name of printer or print queue on that server” box, and then click [OK].

HHHH Confirm to select the name of the printer whose driver you want to install, and then click [Next >].

IIII Change the name of the printer if you want, and then click [Next >].

Configure the default printer as necessary. Check [Yes] to set the printer as the default printer.

JJJJ Click [Next >].

KKKK Select whether or not you want to print a test page, and then click [Next>].

LLLL Click [Finish].

Start printer driver installation.

Note

❒ During installation, the [Digital Signature Not Found] dialog box may appear. In this case, click [Yes]

to continue the installation.

MMMM Set up the options.

Note

❒ You can specify the “User Code” with the printer properties after installing the printer driver. See

printer driver's Help.

Reference

For more information about option settings, see p.88 “Setting Up Options”.
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Changing Port Settings

Follow the steps to change SmartDeviceMonitor for Client settings, such as the proxy server settings

or IPP URL.

Note

❒  There are no settings for the NetBEUI protocol.

AAAA From the [Printers] window, click the icon of the printer you want to use. On the [File] menu,

click [Properties].

BBBB Click the [Ports] tab, and then click [Configure Port].

The [Port Settings] dialog box appears.

• For TCP/IP protocol, you can configure Timeout Settings.

Note

❒ If you cannot set items on the [Recovery/Parallel Printing] tab, follow the procedure below.

A Click [Cancel] to close the [Port Configuration:] dialog box.

B Start SmartDeviceMonitor for Client, and then right-click the SmartDeviceMonitor for Cli-

ent icon on the taskbar.

C Click [Extended Features Settings], and then select the [Set Recovery/Parallel Printing for each

port] check box.

D Click [OK] to close the [Extended Features Settings] dialog box.

• For IPP, you can configure User Settings, Proxy Settings and Timeout Settings.

Note

❒ For more information about these settings, see SmartDeviceMonitor for Client Help file.
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Printing with Parallel Connection

Preparation

To use a printer connected to the parallel interface, select “LPT1:” when installing the printer driver.

Installing the PCL 5c or RPCS Printer Driver

AAAA Close all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

Important

❒ Never have two versions of the same printer driver installed on your system at the same time.

When upgrading to a new version of the printer driver, delete the old version, and then install the

new one.

Note

❒ Auto Run might not automatically work with certain OS settings. In this case, launch “Setup.exe”

located on the CD-ROM root directory.

CCCC Select a language to change the interface language, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), En-

glish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Ned-

erlands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),

Svenska (Swedish)

DDDD Select [PCL/RPCS Printer Drivers].
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EEEE The software license agreement appears in the [License Agreement] dialog box.

After reading through all of the contents, click [I accept the agreement] to agree with the license

agreement, and then click [Next].

FFFF Select a printer drivers you want to use when the “Printer Program” dialog box appears.

You can select more than one printer driver.

GGGG Check [Printer Name] to select the model(s) of printer you want to use.

To change the printer name, change it in the [Change settings for 'Printer Name'] box.

HHHH Double-click the printer name to display the printer settings.

Note

❒ The details shown for [Comment:], [Driver:], and [Port:] vary depending on the operating system

being used, the model of printer selected, and the port being used.

IIII After confirming [Port:] that the location for [LPT1:] shown.

JJJJ Configure the default printer as necessary.

❖❖❖❖ Default Printer
Check [Default Printer] to set the printer as the default printer.

KKKK Click [Continue] to start printer driver installation.

Note

❒ During installation, the [Digital Signature Not Found] dialog box may appear. In this case, click [Yes]

to continue the installation.
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LLLL When the [Select Program] dialog box appears, click [Finish].

MMMM When the installation completion dialog box appears, click [Finish].

NNNN Set up the options.

Note

❒ You must set up the options when the bidirectional transmission is disabled.

❒ For more information about the status of the bidirectional transmission, see p.89 “Bidirectional

transmission”.

Reference

For more information about option settings, see p.88 “Setting Up Options”.
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Installing the PostScript Printer Driver

AAAA Close all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

Important

❒ Never have two versions of the same printer driver installed on your system at the same time.

When upgrading to a new version of the printer driver, delete the old version, and then install the

new one.

Note

❒ Auto Run might not automatically work with certain OS settings. In this case, launch “Setup.exe”

located on the CD-ROM root directory.

CCCC Select a language to change the interface language, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), En-

glish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Ned-

erlands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),

Svenska (Swedish)

Note

❒ The printer driver with the selected language will be installed. The printer driver will be installed

in English if you select the following languages: Portugues, Suomi

DDDD Click [PostScript 3 Printer Driver].

“Add Printer Wizard” starts.
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EEEE Click [Next].

FFFF Click [Local Printer], and then click [Next].

A dialog box for selecting the printer manufacturer and model name appears.

GGGG Click to select the name of the printer whose driver you want to install, and then click [Next].

HHHH Change the name of the printer if you want, and then click [Next].

IIII Select whether or not you want to print a test page, and then click [Finish].

Start printer driver installation.

Note

❒ During installation, the [Digital Signature Not Found] dialog box may appear. In this case, click [Yes]

to continue the installation.

JJJJ Set up the options.

Reference

For more information about option settings, see p.88 “Setting Up Options”.

KKKK Restart the computer.
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Installing the Printer Driver Using USB

This section describes basic instructions for installing the printer drivers using USB.

Preparation

Before installation, check the status of the computer to which the USB cable is connected is as de-

scribed below.

• Only the operating system should be running.

• Printing should not be in progress.

Limitation

❒ Installing a printer driver requires the Administrators permission. When you install a printer driver,

log on using an account that has the Administrators permission.

Note

❒ When the USB cable is used for the first time, the [Found New Hardware Wizard] dialog box appears,

and Windows 2000's [USB Printing Support] will be installed automatically.

❒ If the printer driver is already installed, the “plug and play” is displayed, and the printer with its port

directed to the USB cable is added to the “Printers” folder.



Operating Instructions Client Reference

86

Windows 2000-Installing the Printer Driver Using USB

The printer drivers can be installed from the provided CD-ROM.

AAAA Click [Next] in the [Found New Hardware Wizard] dialog box.

BBBB Select the [Search for a suitable driver for my device (recommended)] check box, and then click

[Next].

CCCC Select the [Specify location] check box, and then click [Next].

DDDD Insert the CD-ROM provided into the CD-ROM drive.

Note

❒ When Auto Run starts, click [Exit].

❒ If you want to inactivate Auto Run, press {{{{Shift}}}} key when inserting the CD-ROM into the drive

and keep it pressed until the computer completes transmission to the drive.

EEEE Click [Browse]to select the printer driver location.

If the CD-ROM drive is D, the locations where each printer driver is stored are as indicated below.

• RPCS

D:\DRIVES\RPCS\WIN2K_XP\(Language)\DISK1

• PCL 5c

D:\DRIVES\PCL5c\WIN2K_XP\(Language)\DISK1

• PostScript 3

D:\DRIVES\PS3\WIN2K_XP\(Language)\DISK1

FFFF Check the printer driver location is displayed in [Copy manufacture's files from], and then click

[OK].
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GGGG Click [Next].

HHHH During installation, the [Digital Signature Not Found] dialog box may appear. In this case, click

[Yes] to continue the installation.

IIII Click [Finish].

If the printer driver is already installed, the Plug and Play is activated, and an icon of the printer for

which [USB001] is specified for [Printing Port] is created in the [Printer] window.

Note

❒ The number after “USB” varies depending on the number of printers connected.
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Setting Up Options

You must set up the options when bidirectional transmission is disabled.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click the icon of the printer you want to use.

CCCC On the [File] menu, click [Properties].

DDDD Click the [Accessories] tab.

Note

❒ If you use the RPCS printer driver, Click the [Change Accessories] tab.

❒ If you use the PS printer driver, Click the [Device Settings] tab.

EEEE Select options you have installed from the [Option] group. And make any settings you require.

FFFF Click [OK].
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----Bidirectional transmission

When bidirectional transmission is enabled, the information about the paper size and feed direction set-

ting is automatically sent to the printer by a computer. You can also confirm the printer status from your

computer.

• Bidirectional transmission is supported by Windows 95/98/Me/2000/XP, Windows Server 2003,

and Windows NT 4.0.

• If you use the RPCS printer driver and bidirectional transmission is enabled, on Windows 2000, the

[Change Accessories] tab is shaded.

Note

❒ The RPCS printer driver supports bidirectional transmission and updates the printer status automatically.

❒ The PCL 5c printer driver supports bidirectional transmission, you can update the printer status

manually.

❒ The PostScript 3 printer driver does not support bidirectional transmission.

To support bidirectional transmission, the following conditions are required:
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❖❖❖❖ When connecting with a parallel cable

• The computer must support bidirectional transmission.

• The printer must be set to bidirectional transmission.

• The Interface cable must support bidirectional transmission.

• The machine must be connected to the computer using the standard parallel cable and parallel

connector.

• Under Windows 2000, [Enable bidirectional support] must be selected and [Enable printer pool-
ing] must not be selected on the [port] tab with RPCS printer driver.

❖❖❖❖ When connecting with the network

• The printer must be set to bidirectional transmission.

• SmartDeviceMonitor for Client included on the CD-ROM must be installed, and the TCP/IP pro-

tocol must be used.

• Under Windows 2000, [Enable bidirectional support] must be selected and [Enable printer pool-

ing] must not be selected on the [port] tab with RPCS printer driver.

❖❖❖❖ When connecting with USB
The printer must be connected to the USB connector of a computer using the USB interface cable.
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4. Windows XP, Windows Server 2003 Configuration

Printing with a Print Server

Printing with a Windows 2000/XP, Windows Server 2003, or Windows NT 4.0 
Print Server

This section describes the procedures for setting up a client in a network that uses Windows 2000/XP,

Windows Server 2003, Windows NT 4.0.

To print from Windows XP or Windows Server 2003, you must install the printer driver and change the

printer port to the print server.

Windows 2000/XP
Windows Server 2003
Windows NT 4.0
Print Server

Windows XP, Windows Server 2003
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Installing the PCL 5c or RPCS Printer Driver

Preparation

To use the print server, install the printer driver by selecting “Network printer server”, and then select

the Windows 2000/XP, Windows Server 2003, or Windows NT 4.0 shared printer. For more infor-

mation about how to install and setting, see Administrator Reference.

This section assumes that the client has already been configured to communicate with a Windows

2000/XP, Windows Server 2003, or Windows NT 4.0 print server. Do not begin the following proce-

dure until the client has been set up and configured correctly.

Limitation

❒ If you print with a print server connected to the machine using the SmartDeviceMonitor port, Recov-

ery Printing and Parallel Printing cannot be used from the client.

❒ If you print with a Windows XP or Windows Server 2003 print server, notification functions of Smart-

DeviceMonitor may not be used with the client. 

Note

❒ If you print with a Windows NT 4.0 print server, install the printer driver before you connect the print

server to the machine.

AAAA Close all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

Important

❒ Never have two versions of the same printer driver installed on your system at the same time. When

upgrading to a new version of the printer driver, delete the old version, and then install the new one.

Note

❒ Auto Run might not automatically work with certain OS settings. In this case, launch “Setup.exe”

located on the CD-ROM root directory.
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CCCC Select a language to change the interface language, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), En-

glish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Ned-

erlands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),

Svenska (Swedish)

DDDD Select [PCL/RPCS Printer Drivers].

EEEE The software license agreement appears in the [License Agreement] dialog box.

After reading through all of the contents, click [I accept the agreement] to agree with the license

agreement, and then click [Next].

FFFF Select a printer drivers you want to use when the “Printer Program” dialog box appears.

You can select more than one printer driver.

GGGG Check [Printer Name] to select the model(s) of printer you want to use.

To change the printer name, change it in the [Change settings for 'Printer Name'] box.

HHHH Double-click the printer name to display the printer settings.

Note

❒ The details shown for [Comment:], [Driver:], and [Port:] vary depending on the operating system

being used, the model of printer selected, and the port being used.

IIII Select [Port:], and then click [Add].

JJJJ Select [Network Printer], and then click [OK].

KKKK Double-click the computer name you want to use as a print server in the “Browse for Printer”

window.
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LLLL Select the printer you want to use, and then click [OK].

MMMM Make sure the location for the selected printer is shown after [Port:].

NNNN Configure the default printer as necessary.

❖❖❖❖ Default Printer
Check [Default Printer] to set the printer as the default printer.

OOOO Click [Continue] to start printer driver installation.

Note

❒ During installation, the [Hardware Installation] dialog box may appear. In this case, click [Continue

Anyway] to continue the installation.

PPPP When the [Select Program] dialog box appears, click [Finish].

QQQQ When the installation completion dialog box appears, click [Finish].

RRRR Set up the options.

Note

❒ You must set up the options when the bidirectional transmission is disabled. For more informa-

tion about the status of the bidirectional transmission, see p.121 “Bidirectional transmission”.

Reference

For more information about option settings, see p.120 “Setting Up Options”.
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Installing the PostScript Printer Driver

AAAA Close all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

Important

❒ Never have two versions of the same printer driver installed on your system at the same time.

When upgrading to a new version of the printer driver, delete the old version, and then install the

new one.

Note

❒ Auto Run might not automatically work with certain OS settings. In this case, launch “Setup.exe”

located on the CD-ROM root directory.

CCCC Select a language to change the interface language, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), En-

glish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Ned-

erlands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),

Svenska (Swedish)

Note

❒ The printer driver with the selected language will be installed. The printer driver will be installed

in English if you select the following languages: Portugues, Suomi

DDDD Click [PostScript 3 Printer Driver].

“Add Printer Wizard” starts.

EEEE Click [Next].
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FFFF Click [Network printer], and then click [Next].

GGGG Click [Next].

HHHH Double-click the computer name you want to use as a print server in the “Shared printers:”

window.

IIII Select the printer you want to use, and then click [Next].

JJJJ Start printer driver installation.

Note

❒ During installation, the [Hardware Installation] dialog box may appear. In this case, click [Continue

Anyway] to continue the installation.

KKKK Click [Next>].

Configure the default printer as necessary. Check [Yes] to set the printer as the default printer.

LLLL Click [Finish].

The installation is complete.

Note

❒ You can specify the “User Code” with the Printer Driver Properties after installing the printer driv-

er. See printer driver's Help.

Reference

For more information about option settings, see p.120 “Setting Up Options”.

MMMM Restart the computer.



Operating Instructions Client Reference

97

Printing without Using a Print Server

Preparation

To use a printer connected to the Ethernet interface or IEEE 802.11b (Wireless LAN) interface, se-

lect “SmartDeviceMonitor”, “Standard TCP/IP Port” or “LPR Port” when installing the printer driver.

• SmartDeviceMonitor See p.98 “Configuring the Protocols” and p.100 “Installing Software” and

p.101 “Installing the PCL 5c or RPCS Printer Driver” or p.107 “Installing the PostScript Printer

Driver”.

• Standard TCP/IP Port, LPR Port See p.98 “Configuring the Protocols” and p.101 “Installing the

PCL 5c or RPCS Printer Driver” or p.107 “Installing the PostScript Printer Driver”.

Note

❒ If you want to use “LPR Port”, “Print Services for UNIX” must be installed.
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Configuring the Protocols

Configuring TCP/IP and IPP for Printing

Follow these instructions to configure the printer and Windows XP or Windows Server 2003 to use the

TCP/IP protocol and IPP.

❖❖❖❖ Configuring the printer
Configure the printer to use the TCP/IP protocol.

• Confirm that the TCP/IP protocol is set to be active. (The factory default is active.)

• Assign an IP address and make other settings required for using the TCP/IP protocol.

Reference

For more information about how to make the above settings, see “Configuring the printer for the

Network”, Administrator Reference.

If DHCP is used to assign IP addresses, see “Using DHCP”, Administrator Reference.

Note

❒ After setting the IP address, use the ping command to confirm that it has been set correctly.

A Click [Start], point to [All Programs], point to [Accessories], and then click [Command Prompt].

B Type the following: (Example IP address is 192.168.15.16)

C:> ping 192.168.15.16

If the address has been configured correctly, the following message appears.

Reply from 192.168.15.16 : bytes=32 time<10ms TTL=32

If the address has been configured incorrectly, the following message appears.

Request timed out.
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❖❖❖❖ Configuring a Windows XP and Windows Server 2003 computer
Follow these steps to configure a Windows XP and Windows Server 2003 computer to use the

TCP/IP protocol.

A Click [Start] on the taskbar, point to [Control Panel], and then click [Network and Internet Con-
nections].

B Click [Local Area Connection].

C On the [File] menu, click [Properties].

D Confirm that “Internet Protocol (TCP/IP)” is selected in the [This connection uses the following
items] box on the [General] tab.

Note

❒ If the check box for TCP/IP protocol is not selected, select the box.

❒ If the TCP/IP protocol is not installed, click [Install...] on the [General] tab and install it. For more

information about installing the TCP/IP protocol, see Windows XP or Windows Server 2003

Help.

E Configure the TCP/IP protocols with the appropriate IP address, subnet mask and other settings.

Confirm that the settings are correct with the network administrator.
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Installing Software

Preparation

If you are not using the print server, install SmartDeviceMonitor for Client, and then install the printer

driver by selecting “SmartDeviceMonitor for Client”. This enables peer-to-peer network printing with

the TCP/IP, NetBEUI, or IPP protocol.

Installing SmartDeviceMonitor for Client

AAAA Close all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

Note

❒ Auto Run might not automatically work with certain OS settings. In this case, launch “Setup.exe”

located on the CD-ROM root directory.

CCCC Select a language to change the interface language, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), English (En-

glish), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Nederlands (Dutch),

Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish), Svenska (Swedish)

DDDD Click [SmartDeviceMonitor for Client / Admin].

EEEE Click to select [SmartDeviceMonitor for Client], and then click [Next >].

FFFF Follow the instructions on the screen.

Note

❒ If you are required to restart the computer after the installation of SmartDeviceMonitor for Client,

restart the computer and continue with necessary configurations.
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Installing the PCL 5c or RPCS Printer Driver

AAAA Close all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

Important

❒ Never have two versions of the same printer driver installed on your system at the same time.

When upgrading to a new version of the printer driver, delete the old version, and then install the

new one.

Note

❒ Auto Run might not automatically work with certain OS settings. In this case, launch “Setup.exe”

located on the CD-ROM root directory.

CCCC Select a language to change the interface language, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), En-

glish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Ned-

erlands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),

Svenska (Swedish)

DDDD Select [PCL/RPCS Printer Drivers].

EEEE The software license agreement appears in the [License Agreement] dialog box.

After reading through all of the contents, click [I accept the agreement] to agree with the license

agreement, and then click [Next].
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FFFF Select a printer drivers you want to use when the “Printer Program” dialog box appears.

You can select more than one printer driver.

GGGG Select the printer model(s) you want to use.

To change the printer name, change it in the [Change settings for 'Printer Name'] box.

HHHH Double-click the printer name to display the printer settings.

Note

❒ The details shown for [Comment:], [Driver:], and [Port:] vary depending on the operating system

being used, the model of printer selected, and the port being used.

IIII Click [Port:], and then select the port you want to use.

• SmartDeviceMonitor

• Standard TCP/IP Port

• LPR Port
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SmartDeviceMonitor

A Click [Add].

B Select [SmartDeviceMonitor], and then click [OK].

C Select a printer you want to use.

❖❖❖❖ TCP/IP

A Click [TCP/IP], and then click [Search].
Available printers will be listed.

B Click the printer you want to use, and then click [OK].

Note

❒ Printers that respond to an IP broadcast from the computer will be displayed. To print to a

printer not listed here, click [Specify Address], and then type the IP address or host name.

You cannot add an address partially similar to that already used. For example, when

“192.168.0.2” is already used, “192.168.0.2xx” cannot be used. Similarly, when

“192.168.0.20” is already used, “192.168.0.2” cannot be used.
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❖❖❖❖ IPP

A Click [IPP].
The IPP setting dialog box appears.

B To specify the IP address of the printer, type “http://printer's-ip-address/printer” in the

[Printer URL] field.

Note

❒ If this machine has the optional network data protection unit installed and server au-

thentication is issued, enter “https://printer's-ip-address/printer” (Internet Explorer 5.01

or a later version must be installed).

(Example IP address: 192.168.15.16)

http://192.168.15.16/printer

https://192.168.15.16/printer

C As necessary, type the names to distinguish the printer in [IPP Port Name]. Type a different

name from those of any existing port name.

If you omit this, the address typed in [Printer URL] will be set as the IPP port name.

D If a proxy server and IPP user name are used, click [Detailed Settings], and then configure

the necessary settings.

Note

❒ For more information about these settings, see SmartDeviceMonitor for Client Help.

E Click [OK].
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Standard TCP/IP Port

A Click [Add].

B Select [Standard TCP/IP], and then click [OK].

C Click [Next] in the “Add Standard TCP/IP Printer Port Wizard” window.

D Type the printer name or IP address in the “Printer Name or IP Address” box.

E Click [Finish] in the “Add Standard TCP/IP Printer Port Wizard” window.

LPR Port

A Click [Add].

B Select [LPR Port], and then click [OK].

C Type the printer's IP address in the “Name or address of server providing lpd” box.

D Type “lp” in the “Name of printer or print queue on that server” box, and then click [OK].

JJJJ Make sure the location for the selected printer is shown after [Port:].

KKKK Configure the default printer as necessary.

❖❖❖❖ Default Printer
Check [Default Printer] to set the printer as the default printer.

LLLL Click [Continue] to start printer driver installation.
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MMMM When the [Select Program] dialog box appears, click [Finish].

Note

❒ During installation, the [Hardware Installation] dialog box may appear. In this case, click [Continue

Anyway] to continue the installation.

NNNN When the installation completion dialog box appears, click [Finish].

OOOO Set up the options.

Note

❒ You must set up the options when the bidirectional transmission is disabled. For more informa-

tion about the status of the bidirectional transmission, see p.121 “Bidirectional transmission”.

Reference

For more information about option settings, see p.120 “Setting Up Options”.
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Installing the PostScript Printer Driver

AAAA Close all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

Important

❒ Never have two versions of the same printer driver installed on your system at the same time.

When upgrading to a new version of the printer driver, delete the old version, and then install the

new one.

Note

❒ Auto Run might not automatically work with certain OS settings. In this case, launch “Setup.exe”

located on the CD-ROM root directory.

CCCC Select a language to change the interface language, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), En-

glish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Ned-

erlands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),

Svenska (Swedish)

Note

❒ The printer driver with the selected language will be installed. The printer driver will be installed

in English if you select the following languages: Portugues, Suomi

DDDD Click [PostScript 3 Printer Driver].

“Add Printer Wizard” starts.

EEEE Click [Next >].
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FFFF Select [Local printer], and then click [Next>].

GGGG Select the port you want to use.

• SmartDeviceMonitor

• Standard TCP/IP Port

• LPR Port

SmartDeviceMonitor

A Click [Create a new port:].

B Select [SmartDeviceMonitor], and then click [Next >].

C Select a printer you want to use.

❖❖❖❖ TCP/IP

A Click [TCP/IP], and then click [Search].
Available printers will be listed.

B Click the printer you want to use, and then click [OK].

Note

❒ Printers that respond to an IP broadcast from the computer will be displayed. To print to a

printer not listed here, click [Specify Address], and then type the IP address or host name.

You cannot add an address partially similar to that already used. For example, when

“192.168.0.2” is already used, “192.168.0.2xx” cannot be used. Similarly, when

“192.168.0.20” is already used, “192.168.0.2” cannot be used. 
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❖❖❖❖ IPP

A Click [IPP].
The IPP setting dialog box appears.

B To specify the IP address of the printer, type “http://printer's-ip-address/printer” in the

[Printer URL] field.

Note

❒ If this machine has the optional network data protection unit installed and server au-

thentication is issued, enter “https://printer's-ip-address/printer” (Internet Explorer 5.01

or a later version must be installed).

(Example IP address: 192.168.15.16)

http://192.168.15.16/printer

https://192.168.15.16/printer

C As necessary, type the names to distinguish the printer in [IPP Port Name]. Type a different

name from those of any existing port name.

If you omit this, the address typed in [Printer URL] will be set as the IPP port name.

D If a proxy server and IPP user name are used, click [Detailed Settings], and then configure

the necessary settings.

Note

❒ For more information about these settings, see SmartDeviceMonitor for Client Help.

E Click [OK].
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Standard TCP/IP Port

A Click [Create a new port:].

B Select [Standard TCP/IP] in [Create a new Port], and then click [Next].

C Select [Standard TCP/IP], and then click [OK].

D Click [Next] in the “Add Standard TCP/IP Printer Port Wizard” window.

E Type the printer name or IP address in the “Printer Name or IP Address” box, and then

click [Next>].

F Click [Finish] in the “Add Standard TCP/IP Printer Port Wizard” window.

LPR Port

A Click [Create a new port:].

B Select [LPR Port] in [Create a new Port], and then click [Next].

C Type the printer's IP address in the “Name or address of server providing lpd” box.

D Type “lp” in the “Name of printer or print queue on that server” box, and then click [OK].

HHHH Confirm to select the name of the printer whose driver you want to install, and then click [Next >].

IIII Change the name of the printer if you want, and then click [Next >].

Configure the default printer as necessary. Check [Yes] to set the printer as the default printer.

JJJJ Click [Next >].

KKKK Select whether or not you want to print a test page, and then click [Next>].
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LLLL Click [Finish].

Start printer driver installation.

Note

❒ During installation, the [Hardware Installation] dialog box may appear. In this case, click [Continue

Anyway] to continue the installation.

MMMM Set up the options.

Reference

For more information about option settings, see p.120 “Setting Up Options”.



Operating Instructions Client Reference

112

Changing Port Settings

Follow the steps to change SmartDeviceMonitor for Client settings, such as the proxy server settings

or IPP URL.

AAAA From the [Printers] window, click the icon of the printer you want to use. On the [File] menu,

click [Properties].

BBBB Click the [Ports] tab, and then click [Configure Port].

The [Port Settings] dialog box appears.

• For TCP/IP protocol, you can configure Timeout Settings.

Note

❒ If you cannot set items on the [Recovery/Parallel Printing] tab, follow the procedure below.

A Click [Cancel] to close the [Port Configuration:] dialog box.

B Start SmartDeviceMonitor for Client, and then right-click the SmartDeviceMonitor for Cli-

ent icon on the taskbar.

C Click [Extended Features Settings], and then select the [Set Recovery/Parallel Printing for each

port] check box.

D Click [OK] to close the [Extended Features Settings] dialog box.

• For IPP, you can configure User Settings, Proxy Settings and Timeout Settings.

Note

❒ For more information about these settings, see SmartDeviceMonitor for Client Help file.
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Printing with Parallel Connection

Preparation

To use a printer connected to the parallel interface, select “LPT1:” when installing the printer driver.

Installing the PCL 5c or RPCS Printer Driver

AAAA Close all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

Important

❒ Never have two versions of the same printer driver installed on your system at the same time.

When upgrading to a new version of the printer driver, delete the old version, and then install the

new one.

Note

❒ Auto Run might not automatically work with certain OS settings. In this case, launch “Setup.exe”

located on the CD-ROM root directory.

CCCC Select a language to change the interface language, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), En-

glish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Ned-

erlands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),

Svenska (Swedish)
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DDDD Select [PCL/RPCS Printer Drivers].

EEEE The software license agreement appears in the [License Agreement] dialog box.

After reading through all of the contents, click [I accept the agreement] to agree with the license

agreement, and then click [Next].

FFFF Select a printer drivers you want to use when the “Printer Program” dialog box appears.

You can select more than one printer driver.

GGGG Check [Printer Name] to select the model(s) of printer you want to use.

To change the printer name, change it in the [Change settings for 'Printer Name'] box.

HHHH Double-click the printer name to display the printer settings.

Note

❒ The details shown for [Comment:], [Driver:], and [Port:] vary depending on the operating system

being used, the model of printer selected, and the port being used.

IIII After confirming [Port:] that the location for [LPT1:] shown.

JJJJ Configure the default printer as necessary.

❖❖❖❖ Default Printer
Check [Default Printer] to set the printer as the default printer.
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KKKK Click [Continue] to start printer driver installation.

Note

❒ During installation, the [Hardware Installation] dialog box may appear. In this case, click [Continue

Anyway] to continue the installation.

LLLL When the [Select Program] dialog box appears, click [Finish].

MMMM When the installation completion dialog box appears, click [Finish].

NNNN Set up the options.

Note

❒ You must set up the options when the bidirectional transmission is disabled.

❒ For more information about the status of the bidirectional transmission, see p.121 “Bidirectional

transmission”.

Reference

For more information about option settings, see p.120 “Setting Up Options”.
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Installing the PostScript Printer Driver

AAAA Close all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

Important

❒ Never have two versions of the same printer driver installed on your system at the same time.

When upgrading to a new version of the printer driver, delete the old version, and then install the

new one.

Note

❒ Auto Run might not automatically work with certain OS settings. In this case, launch “Setup.exe”

located on the CD-ROM root directory.

CCCC Select a language to change the interface language, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), En-

glish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Ned-

erlands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),

Svenska (Swedish)

Note

❒ The printer driver with the selected language will be installed. The printer driver will be installed

in English if you select the following languages: Portugues, Suomi

DDDD Click [PostScript 3 Printer Driver].

“Add Printer Wizard” starts.
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EEEE Click [Next].

FFFF Click [Local Printer], and then click [Next].

GGGG Click the port you want to use, and then click [Next].

A dialog box for selecting the printer manufacturer and model name appears.

HHHH Click to select the name of the printer whose driver you want to install, and then click [Next].

IIII Change the name of the printer if you want, and then click [Next].

JJJJ Select whether or not you want to print a test page, and then click [Finish].

Start printer driver installation.

Note

❒ During installation, the [Hardware Installation] dialog box may appear. In this case, click [Continue

Anyway] to continue the installation.

KKKK Set up the options.

Reference

For more information about option settings, see p.120 “Setting Up Options”.

LLLL Restart the computer.
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Installing the Printer Driver Using USB

This section describes basic instructions for installing the printer drivers using USB. The printer drivers

can be installed from the provided CD-ROM.

Preparation

Before installation, check the status of the computer to which the USB cable is connected is as de-

scribed below.

• Only the operating system should be running.

• Printing should not be in progress.

Limitation

❒ Installing a printer driver requires the Administrators permission. When you install a printer driver,

log on using an account that has the Administrators permission.

Note

❒ When the USB cable is used for the first time, the [Found New Hardware Wizard] dialog box appears,

and Windows XP or Windows Server 2003's [USB Printing Support] will be installed automatically.

❒ If the printer driver is already installed, the “plug and play” is displayed, and the printer with its port

directed to the USB cable is added to the “Printers” folder.
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Windows XP, Windows Server 2003-Installing the Printer Driver Using USB

The printer drivers can be installed from the provided CD-ROM.

AAAA Select the [Install from list or specific location (Advanced)] check box in the [Found New Hardware

Wizard] dialog box, and then click [Next].

BBBB Hold down the left {{{{SHIFT}}}} key and insert the CD-ROM into the CD-ROM drive.

Note

❒ Keep the left {{{{SHIFT}}}} key held down until the computer has finished accessing the CD-ROM.

❒ If the Auto Run program starts, click [Cancel], and then [Exit].

CCCC Select the [Include this location in the search]check box under [Search for the best driver in these

location], and then click [Browse] to select the printer driver location.

If the CD-ROM drive is D, the locations where each printer driver is stored are as indicated below.

• RPCS

D:\DRIVES\RPCS\WIN2K_XP\(Language)\DISK1

• PCL 5c

D:\DRIVES\PCL5c\WIN2K_XP\(Language)\DISK1

• PostScript 3

D:\DRIVES\PS3\WIN2K_XP\(Language)\DISK1

DDDD Check the printer driver location is displayed, and then click [Next].

EEEE Click [Continue].

FFFF Click [Finish].
If installation is successful, an icon of the printer for which [USB001] is specified for [Printing Port]
is created in the [Printer] window.

Note

❒ The number after “USB” varies depending on the number of printers connected.
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Setting Up Options

You must set up the options when bidirectional transmission is disabled.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers and Faxes].

The [Printers and Faxes] window appears.

BBBB Click the icon of the printer you want to use.

CCCC On the [File] menu, click [Properties].

DDDD Click the [Accessories] tab.

Note

❒ If you use the RPCS printer driver, Click the [Change Accessories] tab.

❒ If you use the PS printer driver, Click the [Device Settings] tab.

EEEE Select options you have installed from the [Option] group. And make any settings you require.

FFFF Click [OK].
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----Bidirectional transmission

When bidirectional transmission is enabled, the information about the paper size and feed direction set-

ting is automatically sent to the printer by a computer. You can also confirm the printer status from your

computer.

• Bidirectional transmission is supported by Windows 95/98/Me/2000/XP, Windows Server 2003,

and Windows NT 4.0.

• If you use the RPCS printer driver and bidirectional transmission is enabled, on Windows XP or

Windows Server 2003, the [Change Accessories] tab is shaded.

Note

❒ The RPCS printer driver supports bidirectional transmission and updates the printer status automatically.

❒ The PCL 5c printer driver supports bidirectional transmission, you can update the printer status

manually.

❒ The PostScript 3 printer driver does not support bidirectional transmission.

To support bidirectional transmission, the following conditions are required:
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❖❖❖❖ When connecting with a parallel cable

• The computer must support bidirectional transmission.

• The printer must be set to bidirectional transmission.

• The Interface cable must support bidirectional transmission.

• The machine must be connected to the computer using the standard parallel cable and parallel

connector.

• Under Windows XP or Windows Server 2003, [Enable bidirectional support] must be selected

and [Enable printer pooling] must not be selected on the [port] tab with RPCS printer driver.

❖❖❖❖ When connecting with the network

• The printer must be set to bidirectional transmission.

• SmartDeviceMonitor for Client included on the CD-ROM must be installed, and the TCP/IP pro-

tocol must be used.

• Under Windows XP or Windows Server 2003, [Enable bidirectional support] must be selected

and [Enable printer pooling] must not be selected on the [port] tab with RPCS printer driver.

❖❖❖❖ When connecting with USB
The printer must be connected to the USB connector of a computer using the USB interface cable.
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5. Windows NT 4.0 Configuration

Printing with a Print Server

Printing with a Windows 2000/XP, Windows Server 2003, or Windows NT 4.0 
Print Server

This section describes the procedures for setting up a client in a network that uses Windows 2000/XP,

Windows Server 2003, Windows NT 4.0.

Printing from Windows NT 4.0, you must install the printer driver and change the printer port to the

print server.

Windows 2000/XP
Windows Server 2003
Windows NT 4.0
Print Server

Windows NT 4.0
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Installing the PCL 5c or RPCS Printer Driver

Preparation

To use the print server, install the printer driver by selecting “Network printer server”, and then select

the Windows 2000/XP, Windows Server 2003, or Windows NT 4.0 shared printer. For more infor-

mation about how to install and setting, see Administrator Reference.

This section assumes that the client has already been configured to communicate with a Windows

2000/XP, Windows Server 2003, or Windows NT 4.0 print server. Do not begin the following proce-

dure until the client has been set up and configured correctly.

Limitation

❒ If you print with a print server connected to the machine using the SmartDeviceMonitor port, Recov-

ery Printing and Parallel Printing cannot be used from the client.

❒ If you print with a Windows XP or Windows Server 2003 print server, notification functions of Smart-

DeviceMonitor may not be used with the client. 

Note

❒ If you print with a Windows NT 4.0 print server, install the printer driver before you connect the print

server to the machine.

AAAA Close all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

Important

❒ Never have two versions of the same printer driver installed on your system at the same time. When

upgrading to a new version of the printer driver, delete the old version, and then install the new one.

Note

❒ Auto Run might not automatically work with certain OS settings. In this case, launch “Setup.exe”

located on the CD-ROM root directory.
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CCCC Select a language to change the interface language, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), En-

glish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Ned-

erlands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),

Svenska (Swedish)

DDDD Select [PCL/RPCS Printer Drivers].

EEEE The software license agreement appears in the [License Agreement] dialog box.

After reading through all of the contents, click [I accept the agreement] to agree with the license

agreement, and then click [Next].

FFFF Select a printer drivers you want to use when the “Printer Program” dialog box appears.

You can select more than one printer driver.

GGGG Check [Printer Name] to select the model(s) of printer you want to use.

To change the printer name, change it in the [Change settings for 'Printer Name'] box.

HHHH Double-click the printer name to display the printer settings.

Note

❒ The details shown for [Comment:], [Driver:], and [Port:] vary depending on the operating system

being used, the model of printer selected, and the port being used.

IIII Select [Port:], and then click [Add].

JJJJ Select [Network Printer], and then click [OK].

KKKK Double-click the computer name you want to use as a print server in the “Browse for Printer”

window.
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LLLL Select the printer you want to use, and then click [OK].

MMMM Make sure the location for the selected printer is shown after [Port:].

NNNN Configure the default printer as necessary.

❖❖❖❖ Default Printer
Check [Default Printer] to set the printer as the default printer.

OOOO Click [Continue] to start printer driver installation.

PPPP When the [Select Program] dialog box appears, click [Finish].

QQQQ When the installation completion dialog box appears, click [Finish].

RRRR Set up the options.

Note

❒ You must set up the options when the bidirectional transmission is disabled. For more informa-

tion about the status of the bidirectional transmission, see p.154 “Bidirectional transmission”.

Reference

For more information about option settings, see p.153 “Setting Up Options”.
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Installing the PostScript Printer Driver

AAAA Close all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

Important

❒ Never have two versions of the same printer driver installed on your system at the same time.

When upgrading to a new version of the printer driver, delete the old version, and then install the

new one.

Note

❒ Auto Run might not automatically work with certain OS settings. In this case, launch “Setup.exe”

located on the CD-ROM root directory.

CCCC Select a language to change the interface language, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), En-

glish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Ned-

erlands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),

Svenska (Swedish)

Note

❒ The printer driver with the selected language will be installed. The printer driver will be installed

in English if you select the following languages: Portugues, Suomi

DDDD Click [PostScript 3 Printer Driver].

“Add Printer Wizard” starts.

EEEE Click [Next].
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FFFF Click [Network printer], and then click [Next].

GGGG Click [Next].

HHHH Double-click the computer name you want to use as a print server in the “Shared printers:”

window.

IIII Select the printer you want to use, and then click [Next].

JJJJ After confirming that the location for the selected printer shown, click [Next].

KKKK Change the name of the printer if you want, and then click [Next].

LLLL Select whether or not you want to print a test page, and then click [Finish].

The installation is complete.

Note

❒ You can specify the “User Code” with the Printer Driver Properties after installing the printer driver.

See printer driver's Help.

Reference

For more information about option settings, see p.153 “Setting Up Options”.

MMMM Restart the computer.
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Printing without Using a Print Server

Preparation

To use a printer connected to the Ethernet interface, select “SmartDeviceMonitor” or “LPR Port”

when installing the printer driver.

• SmartDeviceMonitor

See p.130 “Configuring the Protocols” and p.134 “Installing Software” and p.136 “Installing the

PCL 5c or RPCS Printer Driver” or p.142 “Installing the PostScript Printer Driver”.

• LPR Port

See p.130 “Configuring the Protocols” and p.136 “Installing the PCL 5c or RPCS Printer Driver”

or p.142 “Installing the PostScript Printer Driver”.

Note

❒ If you want to use “LPR Port”, “Microsoft TCP/ IP Printing” must be installed.
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Configuring the Protocols

Configuring TCP/IP and IPP for Printing

Follow these instructions to configure the printer and Windows NT 4.0 to use the TCP/IP protocol and

IPP.

❖❖❖❖ Configuring the printer
Configure the printer to use the TCP/IP protocol.

• Confirm that the TCP/IP protocol is set to be active. (The factory default is active.)

• Assign an IP address and make other settings required for using the TCP/IP protocol.

Reference

For more information about how to make the above settings, see “Configuring the printer for the

Network”, Administrator Reference.

If DHCP is used to assign IP addresses, see “Using DHCP”, Administrator Reference.

Note

❒ After setting the IP address, use the ping command to confirm that it has been set correctly.

A Click [Start], point to [Programs], and then click [Command Prompt].

B Type the following: (Example IP address is 192.168.15.16)

C:> ping 192.168.15.16

If the address has been configured correctly, the following message appears.

Reply from 192.168.15.16 : bytes=32 time<10ms TTL=32

If the address has been configured incorrectly, the following message appears.

Request timed out.Request timed out.
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❖❖❖❖ Configuring a Windows NT 4.0 computer
Follow these steps to configure a Windows NT 4.0 computer to use the TCP/IP protocol.

A Open [Control Panel] and double-click the [Network] icon. Confirm that “TCP/IP Protocol” is

listed in the [Network protocols] box under the [Protocols] tab.

Note

❒ If the TCP/IP protocol is not installed, click [Add] under the [Protocols] tab and install it. For

more information about installing the TCP/IP protocol, see Windows NT 4.0 Help.

B Configure the TCP/IP protocols with the appropriate IP address, subnet mask and other settings.

Confirm that the settings are correct with the network administrator.

C Click the [Services] tab, and confirm that “Microsoft TCP/IP Printing” is installed.

If “Microsoft TCP/IP Printing” is not installed, click [Add] under the [Services] tab, and install

it. For more information about installing and configuring network services, see Windows NT 4.0

Help.
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Configuring NetBEUI for Printing

Follow these instructions to configure the printer and Windows NT 4.0 to use the NetBEUI protocol.

Preparation

To use NetBEUI, use the SmartDeviceMonitor for Client port.

❖❖❖❖ Configuring the printer
Enable SMB to print using NetBEUI (The default is active).

Reference

For more information about how to make the above settings, see “Configuring the printer for the

Network”, Administrator Reference.

❖❖❖❖ Configuring a Windows NT 4.0 computer
Install the NetBEUI protocol on the Windows NT 4.0 computer, and change the LAN adapter num-

ber (Lana Number).

A Open [Control Panel] and double-click the [Network] icon. Confirm that “NetBEUI Protocol” is

listed in the [Network Protocols] box under the [Protocols] tab.

Note

❒ If the NetBEUI protocol is not installed, click [Add...] under the [Protocols] tab, and install it. For

more information about installing the NetBEUI protocol, see Windows NT 4.0 Help.

B Change the Lana Number. Click the [Services] tab, click “NetBIOS Interface” in the [Network

Services:] box, and click [Properties].

C Click the Lana Number corresponding to the Nbf protocol of the [Network Route] headline, and

click [Edit].
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D Type “0” as the Lana Number.

Note

❒ If another protocol’s Lana Number is configured at “0”, change it to another number other than “0”.

E Click [OK].

F Click [Close], and close the [Network] dialog box.

G After confirming the message to restart, click [Yes].

Note

❒ After you change the Lana Number, you must restart the computer.
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Installing Software

Preparation

If you are not using the print server, install SmartDeviceMonitor for Client, and then install the printer

driver by selecting “SmartDeviceMonitor for Client”. This enables peer-to-peer network printing with

the TCP/IP, NetBEUI, or IPP protocol.

Installing SmartDeviceMonitor for Client

AAAA Close all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

Important

❒ Never have two versions of the same printer driver installed on your system at the same time.

When upgrading to a new version of the printer driver, delete the old version, and then install the

new one.

Note

❒ Auto Run might not automatically work with certain OS settings. In this case, launch “Setup.exe”

located on the CD-ROM root directory.

CCCC Select a language to change the interface language, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), En-

glish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Ned-

erlands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),

Svenska (Swedish)
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DDDD Click [SmartDeviceMonitor for Client / Admin].

EEEE Click to select [SmartDeviceMonitor for Client], and then click [Next >].

FFFF Follow the instructions on the screen.

Note

❒ If you are required to restart the computer after the installation of SmartDeviceMonitor for Client,

restart the computer and continue with necessary configurations.
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Installing the PCL 5c or RPCS Printer Driver

AAAA Close all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

Important

❒ Never have two versions of the same printer driver installed on your system at the same time.

When upgrading to a new version of the printer driver, delete the old version, and then install the

new one.

Note

❒ Auto Run might not automatically work with certain OS settings. In this case, launch “Setup.exe”

located on the CD-ROM root directory.

CCCC Select a language to change the interface language, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), En-

glish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Ned-

erlands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),

Svenska (Swedish)

DDDD Select [PCL/RPCS Printer Drivers].

EEEE The software license agreement appears in the [License Agreement] dialog box.

After reading through all of the contents, click [I accept the agreement] to agree with the license

agreement, and then click [Next].
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FFFF Select a printer drivers you want to use when the “Printer Program” dialog box appears.

You can select more than one printer driver.

GGGG Select the printer model(s) you want to use.

To change the printer name, change it in the [Change settings for 'Printer Name'] box.

HHHH Double-click the printer name to display the printer settings.

Note

❒ The details shown for [Comment:], [Driver:], and [Port:] vary depending on the operating system

being used, the model of printer selected, and the port being used.

IIII Click [Port:], and then select the port you want to use.

• SmartDeviceMonitor

• LPR Port
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SmartDevice Port

A Click [Add].

B Select [SmartDeviceMonitor], and then click [OK].

C Select a printer you want to use.

❖❖❖❖ TCP/IP

A Click [TCP/IP], and then click [Search].
Available printers will be listed.

B Click the printer you want to use, and then click [OK].

Note

❒ Printers that respond to an IP broadcast from the computer will be displayed. To print to a

printer not listed here, click [Specify Address], and then type the IP address or host name.

❒ You cannot add an address partially similar to that already used. For example, when

“192.168.0.2” is already used, “192.168.0.2xx” cannot be used. Similarly, when

“192.168.0.20” is already used, “192.168.0.2” cannot be used. 
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❖❖❖❖ NetBEUI

A Click [NetBEUI], and then click [Search].
A list of printers that can be used by the NetBEUI protocol appears.

B Click the printer you want to use, and then click [OK].

Note

❒ Printers that respond to a broadcast from the computer will be displayed. To print to a

printer not listed here, click [Specify Address], and then type the NetBEUI address. Confirm

the NetBEUI address on the network is on the configuration page. For more information

about printing the configuration page, see “Printing a Configuration Page”, Administrator

Reference. NetBEUI address appears as “\RNPxxxxxxx” on the configuration page. Type

the printer's network path name in the form of “%%Computer name\Share name”. Do not

type “\” as head characters but “%%”.

❒ You cannot print to printers beyond routers.
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❖❖❖❖ IPP

A Click [IPP].
The IPP settings dialog box appears.

B To specify the IP address of the printer, type “http://printer's-ip-address/printer” in the

[Printer URL] field.

Note

❒ If this machine has the optional network data protection unit installed and server au-

thentication is issued, enter “https://printer's-ip-address/printer” (Internet Explorer 5.01

or a later version must be installed).

(Example IP address: 192.168.15.16)

http://192.168.15.16/printer

https://192.168.15.16/printer

C As necessary, type the names to distinguish the printer in [IPP Port Name]. Type a different

name from those of any existing port name.

If you omit this, the address typed in [Printer URL] will be set as the IPP port name.

D If a proxy server and IPP user name are used, click [Detailed Settings], and then configure

the necessary settings.

Note

❒ For more information about these settings, see SmartDeviceMonitor for Client Help.

E Click [OK].
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LPR Port

A Click [Add].

B Select [LPR Port], and then click [OK].

Note

❒ If [LPR Port] is not displayed, “Microsoft TCP/IP Printing” is not installed. Click [Add] on the

[Service] tab to install “Microsoft TCP/IP Printing”. For more information about installing the

“Microsoft TCP/IP Printing”, see Windows NT 4.0 Help.

C Type the printer's IP address in the “Name or address of server providing lpd” box.

D Type “lp” in the “Name of printer or print queue on that server” box, and then click [OK].

JJJJ Make sure the location for the selected printer is shown after [Port:].

KKKK Configure the default printer as necessary.

❖❖❖❖ Default Printer
Check [Default Printer] to set the printer as the default printer.

LLLL Click [Continue] to start printer driver installation.

MMMM When the [Select Program] dialog box appears, click [Finish].

NNNN When the installation completion dialog box appears, click [Finish].

OOOO Set up the options.

Note

❒ You must set up the options when the bidirectional transmission is disabled. For more informa-

tion about the status of the bidirectional transmission, see p.154 “Bidirectional transmission”.

Reference

For more information about option settings, see p.153 “Setting Up Options”.
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Installing the PostScript Printer Driver

AAAA Close all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

Important

❒ Never have two versions of the same printer driver installed on your system at the same time.

When upgrading to a new version of the printer driver, delete the old version, and then install the

new one.

Note

❒ Auto Run might not automatically work with certain OS settings. In this case, launch “Setup.exe”

located on the CD-ROM root directory.

CCCC Select a language to change the interface language, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), En-

glish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Ned-

erlands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),

Svenska (Swedish)

Note

❒ The printer driver with the selected language will be installed. The printer driver will be installed

in English if you select the following languages: Portugues, Suomi

DDDD Click [PostScript 3 Printer Driver].

“Add Printer Wizard” starts.

EEEE Click [Next].
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FFFF Select the port you want to use.

• SmartDeviceMonitor

• LPR Port

SmartDeviceMonitor

A Click [Add Port:].

B Select [SmartDeviceMonitor], and then [New Port...].

C Select a printer you want to use.

❖❖❖❖ TCP/IP

A Click [TCP/IP], and then click [Search].
Available printers will be listed.

B Click the printer you want to use, and then click [OK].

Note

❒ Printers that respond to an IP broadcast from the computer will be displayed. To print to a

printer not listed here, click [Specify Address], and then type the IP address or host name.

❒ You cannot add an address partially similar to that already used. For example, when

“192.168.0.2” is already used, “192.168.0.2xx” cannot be used. Similarly, when

“192.168.0.20” is already used, “192.168.0.2” cannot be used. 
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❖❖❖❖ NetBEUI

A Click [NetBEUI], and then click [Search].
A list of printers that can be used by the NetBEUI protocol appears.

B Click the printer you want to use, and then click [OK].

Note

❒ Printers that respond to a broadcast from the computer will be displayed. To print to a

printer not listed here, click [Specify Address], and then type the NetBEUI address. Confirm

the NetBEUI address on the network is on the configuration page. For more information

about printing the configuration page, see “Printing a Configuration Page”, Administrator

Reference. NetBEUI address appears as “\RNPxxxxxxx” on the configuration page. Type

the printer's network path name in the form of “%%Computer name\Share name”. Do not

type “\” as head characters but “%%”.

❒ You cannot print to printers beyond routers.
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❖❖❖❖ IPP

A Click [IPP].
The IPP setting dialog box appears.

B To specify the IP address of the printer, type “http://printer's-ip-address/printer” in the

[Printer URL] field.

Note

❒ If this machine has the optional network data protection unit installed and server au-

thentication is issued, enter “https://printer's-ip-address/printer” (Internet Explorer 5.01

or a later version must be installed).

(Example IP address: 192.168.15.16)

http://192.168.15.16/printer

https://192.168.15.16/printer

C As necessary, type the names to distinguish the printer in [IPP Port Name]. Type a different

name from those of any existing port name.

If you omit this, the address typed in [Printer URL] will be set as the IPP port name.

D If a proxy server and IPP user name are used, click [Detailed Settings] and configure the

necessary settings.

Note

❒ For more information about these settings, see SmartDeviceMonitor for Client Help.

E Click [OK].
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LPR Port

A Click [Add Port:].

B Select [LPR Port], and then click [OK].

C Type the printer's IP address in the “Name or address of server providing lpd” box.

D Type “lp” in the “Name of printer or print queue on that server” box, and then click [OK].

GGGG Confirm to select the name of the printer whose driver you want to install, and then click [Next >].

HHHH Change the name of the printer if you want, and then click [Next >].

Configure the default printer as necessary. Check [Yes] to set the printer as the default printer.

IIII Select whether or not you want to print a test page, and then click [Finish].

Start printer driver installation.

JJJJ Set up the options.

Note

❒ You can specify the “User Code” with the Printer Properties after installing the printer driver. See

printer driver's Help.

Reference

For more information about option settings, see p.153 “Setting Up Options”.

KKKK Restart the computer.
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Changing Port Settings

Follow the steps to change SmartDeviceMonitor for Client settings, such as the proxy server settings

or IPP URL.

Note

❒  There are no settings for the NetBEUI protocol.

AAAA From the [Printers] window, click the icon of the printer you want to use. On the [File] menu,

click [Properties].

BBBB Click the [Ports] tab, and then click [Configure Port].

The [Port Settings] dialog box appears.

• For TCP/IP protocol, you can configure Timeout Settings.

Note

❒ If you cannot set items on the [Recovery/Parallel Printing] tab, follow the procedure below.

A Click [Cancel] to close the [Port Configuration:] dialog box.

B Start SmartDeviceMonitor for Client, and then right-click the SmartDeviceMonitor for Cli-

ent icon on the taskbar.

C Click [Extended Features Settings], and then select the [Set Recovery/Parallel Printing for each

port] check box.

D Click [OK] to close the [Extended Features Settings] dialog box.

• For IPP, you can configure User Settings, Proxy Settings and Timeout Settings.

Note

❒ For more information about these settings, see SmartDeviceMonitor for Client Help.
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Printing with Parallel Connection

Preparation

To use a printer connected to the parallel interface, select “LPT1:” when installing the printer driver.

Installing the PCL 5c or RPCS Printer Driver

Preparation

The target printer must be turned on before starting the installation process.

AAAA Close all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

Important

❒ Never have two versions of the same printer driver installed on your system at the same time.

When upgrading to a new version of the printer driver, delete the old version, and then install the

new one.

Note

❒ Auto Run might not automatically work with certain OS settings. In this case, launch “Setup.exe”

located on the CD-ROM root directory.

CCCC Select a language to change the interface language, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), En-

glish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Ned-

erlands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),

Svenska (Swedish)
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DDDD Select [PCL/RPCS Printer Drivers].

EEEE The software license agreement appears in the [License Agreement] dialog box.

After reading through all of the contents, click [I accept the agreement] to agree with the license

agreement, and then click [Next].

FFFF Select a printer drivers you want to use when the “Printer Program” dialog box appears.

You can select more than one printer driver.

GGGG Check [Printer Name] to select the model(s) of printer you want to use.

To change the printer name, change it in the [Change settings for 'Printer Name'] box.

HHHH Double-click the printer name to display the printer settings.

Note

❒ The details shown for [Comment:], [Driver:], and [Port:] vary depending on the operating system

being used, the model of printer selected, and the port being used.

IIII After confirming [Port:] that the location for [LPT1:] shown.

JJJJ Configure the default printer as necessary.

❖❖❖❖ Default Printer
Check [Default Printer] to set the printer as the default printer.

KKKK Click [Continue] to start printer driver installation.

LLLL When the [Select Program] dialog box appears, click [Finish].
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MMMM When the installation completion dialog box appears, click [Finish].

NNNN Set up the options.

Note

❒ You must set up the options when the bidirectional transmission is disabled. For more informa-

tion about the status of the bidirectional transmission, see p.154 “Bidirectional transmission”.

Reference

For more information about option settings, see p.153 “Setting Up Options”.
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Installing the PostScript Printer Driver

AAAA Close all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

Important

❒ Never have two versions of the same printer driver installed on your system at the same time.

When upgrading to a new version of the printer driver, delete the old version, and then install the

new one.

Note

❒ Auto Run might not automatically work with certain OS settings. In this case, launch “Setup.exe”

located on the CD-ROM root directory.

CCCC Select a language to change the interface language, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), En-

glish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Ned-

erlands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),

Svenska (Swedish)

Note

❒ The printer driver with the selected language will be installed. The printer driver will be installed

in English if you select the following languages: Portugues, Suomi

DDDD Click [PostScript 3 Printer Driver].

“Add Printer Wizard” starts.
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EEEE Click [Next].

FFFF Click the port you want to use, and then click [Next].

A dialog box for selecting the printer manufacturer and model name appears.

GGGG Click to select the name of the printer whose driver you want to install, and then click [Next].

HHHH Change the name of the printer if you want, and then click [Next].

IIII Click [Next].

JJJJ Select whether or not you want to print a test page, and then click [Finish].

Set up the options with the printer driver.

Reference

For more information about option settings, see p.153 “Setting Up Options”.

KKKK Restart the computer.
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Setting Up Options

You must set up the options when bidirectional transmission is disabled.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click the icon of the printer you want to use.

CCCC On the [File] menu, click [Properties].

DDDD Click the [Accessories] tab.

Note

❒ If you use the RPCS printer driver, Click the [Change Accessories] tab.

❒ If you use the PostScript printer driver, Click the [Device Settings] tab.

EEEE Select options you have installed from the [Option] group. And make any settings you require.

FFFF Click [OK].
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----Bidirectional transmission

When bidirectional transmission is enabled, the information about the paper size and feed direction set-

ting is automatically sent to the printer by a computer. You can also confirm the printer status from your

computer.

• Bidirectional transmission is supported by Windows 95/98/Me/2000/XP, Windows Server 2003,

and Windows NT 4.0.

• If you use the RPCS printer driver and bidirectional transmission is enabled, on Windows 95/98/Me,

the unavailable functions are shaded.

Note

❒ The RPCS printer driver supports bidirectional transmission and updates the printer status automat-

ically.

❒ The PCL 5c printer driver supports bidirectional transmission, you can update the printer status

manually.

❒ The PostScript 3 printer driver does not support bidirectional transmission.

To support bidirectional transmission, the following conditions are required:
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❖❖❖❖ When connecting with a parallel cable

• The computer must support bidirectional transmission.

• The printer must be set to bidirectional transmission.

• The Interface cable must support bidirectional transmission.

• The machine must be connected to the computer using the standard parallel cable and parallel

connector.

• Under Windows NT 4.0, [Enable bidirectional support] must be selected and [Enable printer pool-
ing] must not be selected on the [port] tab with RPCS printer driver.

❖❖❖❖ When connecting with the network

• The printer must be set to bidirectional transmission.

• SmartDeviceMonitor for Client included on the CD-ROM must be installed, and the TCP/IP pro-

tocol must be used.

• Under Windows NT 4.0, [Enable bidirectional support] must be selected and [Enable printer pool-

ing] must not be selected on the [port] tab with RPCS printer driver.

• Under Windows NT 4.0, specified IP address in the “Microsoft TCP/IP printing” is used.
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6. Mac OS Configuration

This section describes how to configure Mac OS.

• If you are using Mac OS, see “Mac OS”.

• If you are using Mac OS X, see p.166 “Mac OS X”.

Mac OS

This section describes how to configure Mac OS to use EtherTalk and USB. The following procedure

describes how to configure Mac OS 9.1. If you are not using Mac OS 9.1, see the manual that comes

with your version of the Mac OS for more information.

Limitation

❒ For use with Mac OS 8.6 or later. (Mac OS X Classic environment is supported.)

❒ For use with a Mac OS, Power PC is required.

Note

❒ The PostScript 3 printer driver is stored in the following folder on the CD-ROM.

Mac OS 8 and 9:PS Driver:(language):Disk1
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Installing the Printer Driver and Software

Preparation

If the AdobePS installation starts under Mac OS X, the desktop automatically changes to the Classic

environment. If you want to set a printer with Mac OS X, see p.166 “Mac OS X”.

Installing the PostScript Printer Driver and PPD File

It is necessary to install a printer driver and a PPD file to print from a Mac OS.

Follow these steps to install a printer driver and a PPD file into a Mac OS using Mac OS 8.6 or later.

PostScript Printer Driver

AAAA Insert the CD-ROM into the CD-ROM drive.

BBBB Double-click the CD-ROM icon.

CCCC Double-click the [Mac OS 8 and 9] folder.

DDDD Double-click the [PS Driver] folder.

EEEE Double-click the folder of the language you use.

FFFF Open [DISK1], and then double-click the installer icon.

GGGG Follow the instructions on the screen.
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PPD File

AAAA Double-click the CD-ROM icon.

BBBB Double-click the [Mac OS 8 and 9] folder.

CCCC Double-click the [Printer Descriptions] folder.

DDDD Double-click the folder of the language you use.

EEEE Open [Disk1].

FFFF Drag the PPD file and the Plugin file into [Printer Descriptions] in [Extensions] in [System Folder].

GGGG Restart the Mac OS.
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Setting Up the PPD File

Preparation

Confirm that the printer is connected to an AppleTalk network before performing the following pro-

cedure.

AAAA On the [Apple] menu, select [Chooser].

BBBB Click the [Adobe PS] icon.

CCCC In the [Select a PostScript Printer:] list, click the name of the printer you want to use.

DDDD Click [Create].

EEEE Click the printer you want to use, and then click [Select].

The PPD file is set up, and the [Adobe PS] icon appears at the left of the printer name in the list.

Next, follow the procedure on p.161 “Setting Up Options” to make the option settings, or close the

[Chooser] dialog box.
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Creating a Desktop Printer icon

Preparation

Confirm that the printer is connected to the USB before performing the following procedure.

To use a printer connected by USB, create a Desktop Printer icon.

AAAA Double-click [Desktop Printer Utility] in the [AdobePS Components] folder.

BBBB Select [AdobePS] in [With:] and [Printer (USB)] in [Create Desktop], and then click [OK].

CCCC Click [Change] in [USB Printer Selection].

DDDD Select the model you are using in [Select a USB Printer:], and then click [OK].

EEEE Click [Auto Setup] in [PostScriptTM Printer Description (PPD) File].

FFFF Click [Create].

GGGG Enter the printer name, and then click [Save].

The printer icon appears on the desktop.

HHHH Exit the Desktop Printer Utility.
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Setting Up Options

AAAA On the [Apple] menu, select [Chooser].

BBBB Click the [Adobe PS] icon.

CCCC In the [Select the PostScript Printer:] list, click the name of the printer you want to use, and then

click [Setup].

DDDD Click [Configure].

A list of options appears.

EEEE Select the option you want to set up, and then select the appropriate setting for it.

Note

❒ If the option you want to set up is not displayed, the PPD file might not be set up correctly. Check

the name of the PPD file shown in the dialog box.

FFFF Click [OK].

The list of options closes.

GGGG Click [OK].

The [Chooser] dialog box appears.

HHHH Close the [Chooser] dialog box.
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Installing the ColorSync profile

ColorSync profile makes it possible for the printer to print colors of similar intensity to those that ap-

pear on your computer display. You must install the ColorSync profile to use this feature.

Note

❒ The ColorSync profile confirms with the color characteristics defined by the International Color Con-

sortium (ICC).

❒ Some computer displays may require particular settings to be controlled by ColorSync. See the doc-

umentation that comes with your display for details.

The following procedure shows how to install the ColorSync profile.

AAAA Start the Mac OS.

BBBB Double-click the hard disk icon, and then open the appropriate folder for installing the Col-

orSync profile.

Note

❒ The location of the appropriate folder may differ depending on the version of the operating sys-

tem. The following are examples:

• System: Preferences: ColorSync profiles

• System: ColorSync profiles

CCCC Insert the CD-ROM into the CD-ROM drive.

The icon of the CD-ROM appears.

DDDD Double-click the CD-ROM icon.

The contents of the CD-ROM appear.

EEEE Double-click the [Mac OS 8 and 9] folder.
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FFFF Double-click the [ColorSyncTM Profiles] folder in the CD-ROM.

GGGG Drag the file to the [ColorSyncTM Profiles] folder on the hard disk.

The ColorSync profile is installed.

Installing the Adobe Type Manager

Note

❒ Close all applications that are running before the installation. Install ATM after you restart the computer.

AAAA Start the Mac OS.

BBBB Insert the CD-ROM into the CD-ROM drive.

CCCC Double-click the CD-ROM icon.

DDDD Double-click the [Mac OS 8 and 9] folder.

EEEE Double-click the [ATM] folder.

FFFF Double-click the [ATM 4.6.2 installer] icon.

GGGG Follow the instructions on the screen.

HHHH When the procedure is complete, restart the computer. ATM will be completely installed only

after restarting.

IIII Select [Control Panel] from the Apple menu, and then select [~ATM].

JJJJ Open the ATM control panel.

Note

❒ For more information about installation, see the User's Guide in the ATM folder.
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Installing screen fonts

The screen fonts described below can be found in the CD-ROM, in the folder named [Fonts].

AAAA Start the Mac OS.

BBBB Insert the CD-ROM into the CD-ROM drive.

The CD-ROM icon appears.

CCCC Double-click the CD-ROM icon.

The contents of the CD-ROM appear.

DDDD Double-click the [Mac OS 8 and 9] folder.

EEEE Double-click the [Fonts] folder.

FFFF Double-click the [Screen font] folder.

GGGG Double- click the [TrueType] or [Type1] folder.

Select the font type you want to use.

HHHH Copy the fonts you want to install in [Fonts] in [System Folder].

A Confirmation dialog box appears.

IIII Click [OK].

The fonts are installed.

JJJJ Restart the Mac OS.
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Using USB Interface

This section explains the setup procedure when using the printer with a USB connection.

Preparation

Install the required files by referring to p.157 “Installing the Printer Driver and Software”.

Connect your Macintosh and the printer using a USB cable.

Limitation

❒ Mac OS is compatible with the standard USB port only.

AAAA Open the [AdobePS Component] folder on the hard disk.

BBBB Double-click [Desktop Printer Utility].

CCCC Select [AdobePS] in [With:] and [Printer (USB)] in [Create Desktop], and then click [OK].

DDDD Click [Change] under [PostScriptTM Printer Description (PPD) File].

EEEE Select the connected printer's PPD file, and then click [Select].

FFFF Click [Change] in [USB Printer Selection].

GGGG Select the model you are using in [Select a USB Printer:], and then click [OK].

HHHH Click [Create].

The following message appears.

IIII Enter the printer name, and then click [Save].

JJJJ Specify the location where the file is to be saved, and the name, and then click [Save].

The printer icon appears on the desktop.

KKKK Exit the Desktop Printer Utility.
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Mac OS X

This section describes how to configure a Mac OS X to use Ether Talk. The following procedure de-

scribes how to configure Mac OS X 10.1. If you are not using Mac OS X 10.1, see the manual that

comes with your version of the Mac OS X for more information.

Limitation

❒ For use with Mac OS X 10.1 or later.

Note

❒ The PPD file is stored in the following folder on the CD-ROM.

Mac OS X:PPD Installer

Installing the PPD File

It is necessary to install a PPD file to print from a Mac OS X.

Preparation

You need an administrator name and a password (phrase). For more information, consult your ad-

ministrator.

AAAA Insert the CD-ROM into the CD-ROM drive.

BBBB Double-click the CD-ROM icon.

CCCC Double-click the [Mac OS X] folder.

DDDD Double-click the installer icon.

EEEE Follow the instructions on the screen.
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Setting Up the PPD File

AAAA Run Print Center.

BBBB Click [Add Printer].

Select [AppleTalk] in the first pop-up menu.

If the zone has been set, select the zone in the second pop-up menu.

CCCC Select the PPD file of the model you are using from the “Printer Model:” pop-up menu, and

then click [Add].

Setting Up Options

Limitation

❒ You cannot make the printer option settings under Mac OS X. Do not make settings for options that

have not been installed.
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Using USB Interface

AAAA Start the Print Center.

BBBB Click [Add].

CCCC Select [USB] on the pop-up menu.

The connected printer is displayed.

DDDD Select the printer, and then select its manufacturer the [Printer Model:] pop-up menu.

A list of printer types appears.

Note

❒ For Mac OS X 10.1.x, a list of model names appears in the [Printer Model:] pop-up menu. Select

the printer's model name, and then proceed to step F. 

EEEE Select the connected printer's name in the list of printer types, and then click [Add].

FFFF Close the [Printer List], and then quit print center.
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Using Rendezvous

When using Mac OS X 10.2.3 or later, you can print using Rendezvous. Ethernet and Wireless LAN

connections can be used.

AAAA Start up the Print Center.

BBBB Click [Add].

CCCC Select [Rendezvous] from the pop-up menu.

The connected printer is displayed.

DDDD Select the printer, and then select its manufacturer the [Printer Model:] pop-up menu.

A list of printer types appears.

EEEE Select the name of the connected printer from the list of printer types, and then click [Add].

FFFF Close the [Printer List] and end the print center.
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Configuring Mac OS

Changing to EtherTalk

Follow the procedure to configure a Mac OS to use EtherTalk.

Reference

For more information about installing the software required for EtherTalk, see the Mac OS manuals.

Mac OS

AAAA Open [Control Panel], and then double-click the [AppleTalk] icon.

BBBB From the [Connect via:] pop-up menu, select “Ethernet”.

CCCC If you change zones, select a name from the [Current zone:] pop-up menu.

DDDD Close the [AppleTalk] control panels.

EEEE Restart the computer.
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Mac OS X

Preparation

You need an administrator name and a password (phrase). For more information, consult your ad-

ministrator.

AAAA Open [System Preference], and then click the [Network] icon.

BBBB Click the [AppleTalk] tab.

CCCC If you change zone, select a name from the [AppleTalk Zone:] pop-up menu.

DDDD When the setting is complete, click [Apple Now].

Configuring the Printer

Use the control panel to activate the AppleTalk protocol. (The factory default is active.)

Reference

For more information about the configuration, see the “Configuring the printer for the Network”, Ad-

ministrator Reference.
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Changing the Printer Name

If the network has several same model printers, the names will be the same. Printers that have the same

name will have their names changed slightly in the Chooser. For example, three printers named “print-

er” will appear in the chooser as “printer0”, “printer1” and “printer2”.

To install from Printer Utility for Mac, see the PostScript 3 Supplement.

Changing the Zone

It may be necessary to change the zone configuration.

To install from Web Image Monitor, see Administrator Reference.
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7. NetWare Configuration

The following explanation assumes NetWare client software is installed on the client, and the environ-

ment is set correctly for NetWare server. When setup is not made, install the necessary software on the

client side beforehand.

Set up the printer driver while Windows is logged on to NetWare's file server.

• OS: Windows 98

• NetWare version: 4.1

• File server name: CAREE

• Queue name: R-QUEUE

Windows Setup

AAAA Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

Important

❒ Never have two versions of the same printer driver installed on your system at the same time.

When upgrading to a new version of the printer driver, delete the old version, and then install the

new one.

Note

❒ Auto Run might not automatically work with certain OS settings. In this case, launch “Setup.exe”

located on the CD-ROM root directory.

BBBB Select a language to change the interface language, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), En-

glish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Ned-

erlands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),

Svenska (Swedish)
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CCCC Select [PCL/RPCS Printer Drivers].

DDDD The software license agreement appears in the [License Agreement] dialog box.

After reading through all of the contents, click [I accept the agreement] to agree with the license

agreement, and then click [Next].

EEEE Select a printer drivers you want to use when the “Printer Program” dialog box appears.

You can select more than one printer driver.

FFFF Check [Printer Name] to select the model(s) of printer you want to use.

To change the printer name, change it in the [Change settings for 'Printer Name'] box.

GGGG Double-click the printer name to display the printer settings.

Note

❒ The details shown for [Comment:], [Driver:], and [Port:] vary depending on the operating system

being used, the model of printer selected, and the port being used.

HHHH Select [Port:], and then click [Add].

IIII Select [Network Printer], and then click [OK].

JJJJ Double-click the name of the NetWare file server on the network tree.

The created queue is displayed.

KKKK Click the print queue, and then click [OK].

LLLL Make sure the location for the selected printer is shown after [Port:].
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MMMM Click [Finish].

The printer driver is installed.

Note

❒ During installation, the [Digital Signature Not Found] dialog box may appear. In this case, click [Yes]

to continue the installation.

❒ During installation, the [Hardware Installation] dialog box may appear. In this case, click [Continue

Anyway] to continue the installation.

NNNN When the [Component selection] dialog box appears, click [Finish].

OOOO When the [Introduction complete] dialog box appears, click [Finish].

PPPP From the [Printers] window, open the printer properties.

Note

❒ When using Windows XP and Windows Server 2003, open the printer properties from the [Print-

ers and Faxes] window. 

Limitation

❒ In order to make changes in the printer properties under Windows 2000, Windows XP Profes-

sional, Windows Server 2003, and Windows NT 4.0, you must have “Printer Management” ac-

cess rights. For this, log on as an Administrators or Power Users group member. 

QQQQ Click the [Printer Settings] tab.

Note

❒ When using Windows 2000/XP, Windows Server 2003 or Windows NT4.0, click the [NetWare set-

ting] tab.
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RRRR Click to clear the [Form Feed] and [Enable Banner] check boxes.

Note

❒ You should not check these boxes because they should be specified using the printer driver. If

they are selected, the printer might not print correctly.

SSSS Click [OK] to close the Printer Properties.

When using the PostScript 3 Printer Driver

Follow these steps to set up for the PostScript 3 printer driver.

AAAA From the [Printers] or [Printers and Faxes] window, open the printer properties.

BBBB Click the [PostScript] tab.

Note

❒ When using Windows 2000/XP, Windows Server 2003 or Windows NT 4.0, click the [Device set-

ting] tab, and then proceed to the step D.

CCCC Click [Advanced].

DDDD Click to clear the [Send CTRL+D before job] and [Send CTRL+D after job] check boxes, and then

Click [OK].

EEEE Click [OK] to close the Printer Properties.
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----If a message is displayed during installation of the printer driver

When there is a driver in the computer that is newer than the one currently being installed, a message

dialog box appears.

In such a case, you cannot install with the Auto Run program. Use the driver that was used in installing

the driver that is displayed in the message, and reinstall with [Add Printer].

A Click [Start], point to [Settings], and then click [Printers].

B Double-click the [Add Printer] icon.

C Follow the wizard to install the driver.

If the printer driver disk is a CD-ROM, the sources of installation are as follows. If the installer starts

up, click [Cancel] to quit it.

If the CD-ROM drive is D, the locations where each printer driver is stored are as indicated below.

• RPCS

D:\DRIVES\RPCS\WIN9X_ME\(Language)\DISK1

• PCL 5c

D:\DRIVES\PCL5c\WIN9X_ME\(Language)\DISK1

• PostScript 3

D:\DRIVES\PS3\WIN9X_ME\(Language)\DISK1
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8. Software and Utilities Included on the CD-ROM

Software and Utilities Included on the CD-ROM

There are three CD-ROMs that come with this printer. These are labeled “Operating Instructions”,

“Printer Drivers and Utilities” and “Desk Top Binder V2 Lite”. The following items are included on

the three separate CD-ROMs.

❖❖❖❖ Font Manager 2000
Helps you to install new screen fonts, or organize and manage fonts already installed on the system.

For more information about Font Manager 2000, see the manual on the CD-ROM labeled “Printer

Drivers and Utilities”.

❖❖❖❖ SmartDeviceMonitor for Admin
An utility for the system administrator to manage printers on the network.

Reference

For more information about SmartDeviceMonitor for Admin, see the SmartDeviceMonitor for Ad-

min Help.

❖❖❖❖ SmartDeviceMonitor for Client
A utility for users to manage their own print status on the network.

Reference

For more information about SmartDeviceMonitor for Client, see the SmartDeviceMonitor for Cli-

ent Help .

❖❖❖❖ USB Printing Support
Using the USB connection on the computer running Windows 98 SE/Me requires to install this utility.
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Viewing the Contents of the CD-ROM

Follow the steps to view the contents of the CD-ROM.

AAAA Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

BBBB Click [Browse This CD-ROM].

Explorer starts and displays the contents of the CD-ROM.
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Printer Drivers for This Printer

Printing requires installation of a printer driver for your operating system. The following drivers are

included on the CD-ROM that comes with this printer.

Printer Language PCL 5c RPCS PostScript 3

Operating system

Windows 95 *1 √ √ √ *10 

Windows 98 *2 √ √ √ *10 

Windows Me *3 √ √ √ *10 

Windows 2000 *4 √ √ √

Windows XP *5 √ √ √

Windows Server 2003 *6 √ √ √

Windows NT 4.0 *7 √ √ √ *9  *10 

Mac OS *8 √ *10 

Mac OS X √ *11 
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*1 Microsoft Windows 95 operating system
*2 Microsoft Windows 98 operating system
*3 Microsoft Windows Me operating system
*4 Microsoft Windows 2000 professional

Microsoft Windows 2000 Server

Microsoft Windows 2000 Advanced Server
*5 Microsoft Windows XP Professional

Microsoft Windows XP Home Edition
*6 Microsoft Windows Server 2003 Standard Edition

Microsoft Windows Server 2003 Enterprise Edition

Microsoft Windows Server 2003 Web Edition
*7 Microsoft Windows NT Server operating system version 4.0, Microsoft Windows NT Workstation op-

erating system version 4.0 in a computer using x86 processors.
*8 Required version is 8.6 or later. (Mac OS X Classic environment is supported.)
*9 Requires Service Pack 6 or later.
*10 The Adobe PostScript printer drivers and PostScript Printer Description (PPD) files are included on the

CD-ROM labeled “Printer Drivers and Utilities”.
*11 The PostScript Printer Description (PPD) files are included on the CD-ROM labeled “Printer Drivers and

Utilities”.

❖❖❖❖ PCL 5c printer driver
This printer driver allows the computer to communicate with the printer via a printer language.

⇒ p.188 “Windows 95/98/Me - Accessing the Printer Properties”

⇒ p.191 “Windows 2000 - Accessing the Printer Properties”

⇒ p.195 “Windows XP, Windows Server 2003 - Accessing the Printer Properties”

⇒ p.199 “Windows NT 4.0 - Accessing the Printer Properties”
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❖❖❖❖ RPCS printer driver
This printer driver allows the computer to communicate with the printer via a printer language. The

preset type user interface is provided in addition to the conventional one.

⇒ p.203 “Windows 95/98/Me - Accessing the Printer Properties”

⇒ p.207 “Windows 2000 - Accessing the Printer Properties”

⇒ p.211 “Windows XP, Windows Server 2003 - Accessing the Printer Properties”

⇒ p.215 “Windows NT 4.0 - Accessing the Printer Properties”

❖❖❖❖ Adobe PostScript Printer Drivers and PPD files
The Adobe PostScript printer drivers and the PPD files are included on the CD-ROM that comes

with this printer. Adobe PostScript printer driver allows the computer to communicate with the

printer via a printer language. The PPD files allow the printer driver to enable the printer specific

functions.

⇒ p.219 “Windows 95/98/Me - Accessing the Printer Properties”

⇒ p.222 “Windows 2000 - Accessing the Printer Properties”

⇒ p.226 “Windows XP, Windows Server 2003 - Accessing the Printer Properties”

⇒ p.230 “Windows NT 4.0 - Accessing the Printer Properties”

⇒ p.234 “Mac OS - Setting up for Printing”

❖❖❖❖ PPD files
The PPD files are included on the CD-ROM that comes with this printer. The PPD files allow the

printer driver to enable the printer specific functions.

See p.234 “Mac OS - Setting up for Printing”.
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SmartDeviceMonitor for Admin

SmartDeviceMonitor for Admin is software that uses the TCP/IP and IPX/SPX protocols to monitor

the printers in a network. It can monitor multiple network printers with IP addresses. We recommend

network administrators to use this software.

❖❖❖❖ File Path
SmartDeviceMonitor for Admin is stored in the following folder on the CD-ROM.

NETWORK\NETMON\ADMIN\DISK1

OS Protocol Stack

Microsoft Windows 95/98/Me TCP/IP provided with Windows 95/98/Me

IPX/SPX provided with Windows 95/98/Me

NetWare network client provided with Windows 95/98

Novell Client for Windows 95/98

Microsoft Windows 2000 TCP/IP provided with Windows 2000

IPX/SPX provided with Windows 2000

NetWare Client provided with Windows 2000

Novell Client for Windows NT/2000

Microsoft Windows XP TCP/IP provided with Windows XP

IPX/SPX provided with Windows XP

NetWare Client provided with Windows XP

Novell Client for Windows XP

Microsoft Windows Server 2003 TCP/IP provided with Windows Server 2003

IPX/SPX provided with Windows Server 2003

NetWare Client provided with Windows Server 2003

Novell Client for Windows Server 2003
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❖❖❖❖ What can it do?
SmartDeviceMonitor for Admin is equipped with the following functions.

• Checks the information on printing, paper exhaustion, and such, on the computer.

• Checks the results of print jobs executed from the computer.

Reference

For the operations of the system administrator, see “Using SmartDeviceMonitor for Admin”, Ad-

ministrator Reference.

For more information about using SmartDeviceMonitor for Admin, see the SmartDeviceMonitor

for Admin Help.

Microsoft Windows NT 4.0 TCP/IP provided with Windows NT

IPX/SPX provided with Windows NT

Client Service for NetWare provided with Windows NT

Novell Client for Windows NT/2000

OS Protocol Stack
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SmartDeviceMonitor for Client

SmartDeviceMonitor for Client is software equipped with the following functions. We recommend all

users of this printer to install this software.

• Provides the function to print in a Peer-to-Peer network, using the TCP/IP protocol, NetBEUI, and

IPP from Windows 95/98/Me/2000/XP, Windows Server 2003, and Windows NT 4.0.

• Uses the TCP/IP and IPX/SPX protocols to constantly monitor the status of devices in a network.

❖❖❖❖ File Path
SmartDeviceMonitor for Client is stored in the following folder on the CD-ROM.

NETWORK\NETMON\CLIENT\DISK1

OS Protocol Stack

Microsoft Windows 95/98/Me TCP/IP provided with Windows 95/98/Me

IPX/SPX provided with Windows 95/98/Me

NetBEUI provided with Windows 95/98/Me

NetWare network client provided with Windows 95/98/Me

Novell Client for Windows 95/98/Me

Microsoft Windows 2000 TCP/IP provided with Windows 2000

IPX/SPX provided with Windows 2000

NetBEUI provided with Windows 2000

NetWare Client provided with Windows 2000

Novell Client for Windows NT/2000

Microsoft Windows XP TCP/IP provided with Windows XP

IPX/SPX provided with Windows XP

NetWare Client provided with Windows XP

Novell Client for Windows XP
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❖❖❖❖ What can it do?
SmartDeviceMonitor for Admin

• Peer-to-Peer print function

• Prints directly on the network printer without a print server.

• Prints on a substitute printer when there are too many jobs accumulated in the specified print-

er, or when an error disables printing (Recovery printing).

• Allocates multiple printings to multiple printers (Parallel Printing).

• Prior group registration of printers specified for Recovery Printing /Parallel Printing.

• Notification function

• An error message warns when there is an error on the specified printer during transfer or print-

ing of data.

• A window opens to notify the completion of printing. You can also select to be notified of the

print condition, such as displaying the notice only when Recovery Printing is executed.

Microsoft Windows Server 2003 TCP/IP provided with Windows Server 2003

IPX/SPX provided with Windows Server 2003

NetWare Client provided with Windows Server 2003

Novell Client for Windows Server 2003

Microsoft Windows NT 4.0 TCP/IP provided with Windows NT

IPX/SPX provided with Windows NT

NetBEUI provided with Windows NT

Client Service for NetWare provided with Windows NT

Novell Client for Windows NT/2000

OS Protocol Stack
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• Monitoring function

• Checks the equipment information on printing, paper exhaustion, and such, on the computer.

• Simultaneously monitors multiple printers in use.

• Checks the printer's network settings and detailed information of devices.

• Enables you to check the log of print jobs using the user ID.

Limitation

❒ Make similar settings for the option configuration of the printer for Recovery/Parallel Printing and

the printer for giving print commands. If the required options necessary for printing, such as the

Paper Feed Unit, are not installed on the substitute printer, that function is disabled.

❒ Load paper of the same size on both the printer for Recovery/Parallel Printing and the printer for

giving print commands. When specifying a particular Paper Tray for printing, load paper of the

same size into that tray.

❒ If the type and devices of the printer for Recovery/Parallel Printing and the printer for giving com-

mands are different, the print results might not turn out identical.

❒ If you select Sample Print or Locked Print, you cannot execute Recovery/Parallel Printing.

Reference

For more information about using SmartDeviceMonitor for Client, See the SmartDeviceMonitor

for Client Help.
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9. Setting up the Printer Driver and Canceling a Print Job 

PCL 5c - Accessing the Printer Properties

Windows 95/98/Me - Accessing the Printer Properties

There are two methods you can use to open the Printer Properties dialog box.

Making default printer settings

To make the default printer settings, first open the Printer Properties dialog box from the [Printers] window.

Note

❒ With some applications, the printer driver's settings are not used, and the application's own default

settings are applied.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click to select the icon of the printer you want to use.

CCCC On the [File] menu, click [Properties].

DDDD Make the necessary settings, and then click [OK].
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----If a message is displayed during installation of the printer driver

When there is a driver in the computer that is newer than the one currently being installed, a message

dialog box appears.

In such a case, you cannot install with the Auto Run program. Use the driver that was used in installing

the driver that is displayed in the message, and reinstall with [Add Printer].

A Click [Start], point to [Settings], and then click [Printers].

B Double-click the [Add Printer] icon.

C Follow the wizard to install the driver.

If the printer driver disk is a CD-ROM, the sources of installation are as follows. If the installer starts

up, click [Cancel] to quit it.

• PCL 5c

DRIVERS\PCL5C\WIN9X_ME\(Language)\DISK1
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Making printer settings from an application

To make the printer settings for a specific application, open the Printer Properties dialog box from that

application. The following example describes how to make settings for the WordPad application that

comes with Windows 95/98/Me.

Note

❒ The actual procedure you should follow to open the Printer Properties dialog box may differ depend-

ing on the application. For more information, see the documentation that comes with the application

you are using.

❒ With some applications, the printer driver's settings are not used, and the application's own default

settings are applied.

❒ Any settings you make in the following procedure are valid for the current application only.

AAAA On the [File] menu, click [Print].

The [Print] dialog box appears.

BBBB Select the printer you want to use in the [Name] list box, and then click [Properties].

The Printer Properties dialog box appears.

CCCC Make the necessary settings, and then click [OK].

DDDD Click [OK] to start printing.
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Windows 2000 - Accessing the Printer Properties

Making printer default settings - Printer Properties

Limitation

❒ To change the printer settings requires Manage Printers permission. Members of the Administrators

and Power Users groups have Manage Printers permission by default. When you set up options,

log on using an account that has Manage Printers permission.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click to select the icon of the printer you want to use.

CCCC On the [File] menu, click [Properties].

The [Printer Properties] appears.

DDDD  Make the necessary settings, and then click [OK].

Note

❒ Settings you make here are used as the default settings for all applications.

❒ Do not set [Form to Tray Assignment].
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----If a message is displayed during installation of the printer driver

When there is a driver in the computer that is newer than the one currently being installed, a message

dialog box appears.

In such a case, you cannot install with the Auto Run program. Use the driver that was used in installing

the driver that is displayed in the message, and reinstall with [Add Printer].

A Click [Start], point to [Settings], and then click [Printers].

B Double-click the [Add Printer] icon.

C Follow the wizard to install the driver.

If the printer driver disk is a CD-ROM, the sources of installation are as follows. If the installer starts

up, click [Cancel] to quit it.

• PCL 5c

DRIVERS\PCL5C\WIN2K_XP\(Language)\DISK1
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Making printer default settings - Printing Preferences Properties

Limitation

❒ To change the printer settings requires Manage Printers permission. Members of the Administrators

and Power Users groups have Manage Printers permission by default. When you set up options,

log on using an account that has Manage Printers permission.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click to select the icon of the printer you want to use.

CCCC On the [File] menu, click [Printing Preferences...].

The Printing Preferences Properties dialog box appears.

DDDD Make the necessary settings, and then click [OK].

Note

❒ Settings you make here are used as the default settings for all applications.
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Making printer settings from an application

To make the printer settings for a specific application, open the Printing Preferences Properties from

that application. The following example describes how to make settings for the WordPad application

that comes with Windows 2000.

Note

❒ The actual procedures you should follow to open the Printing Preferences Properties may differ de-

pending on the application. For more information, see the documentation that comes with the appli-

cation you are using.

❒ Any settings you make in the following procedure are valid for the current application only.

AAAA On the [File] menu, click [Print...].

The [Print] dialog box appears.

BBBB Select the printer you want to use in the [Select Printer] box.

CCCC Make the necessary settings, and then click [Apply] to start your printing.
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Windows XP, Windows Server 2003 - Accessing the Printer Properties

Making printer default settings - Printer Properties

Limitation

❒ To change the printer settings requires Manage Printers permission. Members of the Administrators

and Power Users groups have Manage Printers permission by default. When you set up options,

log on using an account that has Manage Printers permission.

AAAA Access the [Printers and Faxes] window from [Start] on the taskbar.

The [Pritners and Faxes] window appears.

BBBB Click to select the icon of the printer you want to use.

CCCC On the [File] menu, click [Properties].

The [Printer Properties] appears.

DDDD  Make the necessary settings, and then click [OK].

Note

❒ Settings you make here are used as the default settings for all applications.

❒ Do not set [Form to Tray Assignment].
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----If a message is displayed during installation of the printer driver

When there is a driver in the computer that is newer than the one currently being installed, a message

dialog box appears.

In such a case, you cannot install with the Auto Run program. Use the driver that was used in installing

the driver that is displayed in the message, and reinstall with [Add Printer].

A Access the [Printers and Faxes] window from [Start] on the taskbar.

B Double-click the [Add Printer] icon.

C Follow the wizard to install the driver.

If the printer driver disk is a CD-ROM, the sources of installation are as follows. If the installer starts

up, click [Cancel] to quit it.

• PCL 5c

DRIVERS\PCL5C\WIN2K_XP\(Language)\DISK1
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Making printer default settings - Printing Preferences Properties

Limitation

❒ To change the printer settings requires Manage Printers permission. Members of the Administrators

and Power Users groups have Manage Printers permission by default. When you set up options,

log on using an account that has Manage Printers permission.

AAAA Access the [Printers and Faxes] window from [Start] on the taskbar.

The [Printers and Faxes] window appears.

BBBB Click to select the icon of the printer you want to use.

CCCC On the [File] menu, click [Printing Preferences...].

The Printing Preferences Properties dialog box appears.

DDDD Make the necessary settings, and then click [OK].

Note

❒ Settings you make here are used as the default settings for all applications.
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Making printer settings from an application

To make the printer settings for a specific application, open the Printing Preferences Properties from

that application. The following example describes how to make settings for the WordPad application

that comes with Windows XP.

Note

❒ The actual procedures you should follow to open the Printing Preferences Properties may differ de-

pending on the application. For more information, see the documentation that comes with the appli-

cation you are using.

❒ Any settings you make in the following procedure are valid for the current application only.

AAAA On the [File] menu, click [Print...].

The [Print] dialog box appears.

BBBB Select the printer you want to use in the [Select Printer] box.

CCCC Make the necessary settings, and then click [Apply] to start your printing.
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Windows NT 4.0 - Accessing the Printer Properties

Making default printer settings - Printer Properties

Limitation

❒ To change the printer settings requires Full Control permission. Members of Administrators, Server

Operators, Print Operators, and Power Users groups have Full Control permission by default. When

you set up options, log on using an account that has Full Control permission. 

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click to select the icon of the printer you want to use.

CCCC On the [File] menu, click [Properties].

The Printer Properties dialog box appears.

DDDD Make the necessary settings, and then click [OK].

Note

❒ Settings you make here are used as the default settings for all applications.

❒ Do not set [Form to Tray Assignment].
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----If a message is displayed during installation of the printer driver

When there is a driver in the computer that is newer than the one currently being installed, a message

dialog box appears.

In such a case, you cannot install with the Auto Run program. Use the driver that was used in installing

the driver that is displayed in the message, and reinstall with [Add Printer].

A Click [Start], point to [Settings], and then click [Printers].

B Double-click the [Add Printer] icon.

C Follow the wizard to install the driver.

If the printer driver disk is a CD-ROM, the sources of installation are as follows. If the installer starts

up, click [Cancel] to quit it.

• PCL 5c

DRIVERS\PCL5C\NT4\(Language)\DISK1
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Making default printer settings - Default Document Properties

Limitation

❒ To change the printer settings requires Full Control access permission. Members of the Administra-

tors, Server Operators, Print Operators, and Power Users groups have Full Control permission by

default. When you set up options, log on using an account that has Full Control permission.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click to select the icon of the printer you want to use.

CCCC On the [File] menu, click [Document Defaults].

The Default Document Properties dialog box appears.

DDDD Make the necessary settings, and then click [OK].

Note

❒ Settings you make here are used as the default settings for all applications.
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Making printer settings from an application

To make the printer settings for a specific application, open the Printer Properties dialog box from that

application. The following example describes how to make settings for the WordPad application that

comes with Windows NT 4.0.

Note

❒ The actual procedure you should follow to open the Printer Properties dialog box may differ depend-

ing on the application. For more information, see the documentation that comes with the application

you are using.

❒ With some applications, the printer driver settings are not used, and the application's own default

settings are applied.

❒ Any settings you make in the following procedure are valid for the current application only.

AAAA On the [File] menu, click [Print].

The [Print] dialog box appears.

BBBB Select the printer you want to use in the [Name] list box, and then click [Properties].

The Printer Properties dialog box appears.

CCCC Make the necessary settings, and then click [OK].

DDDD Click [OK] to start printing.
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RPCS - Accessing the Printer Properties

Windows 95/98/Me - Accessing the Printer Properties

There are two windows types you can use to open the Printer Properties dialog box.

“Multi-tab” is used as an example in this manual. See Help for information about changing the windows

types.

❖❖❖❖ Multi-tab
This is the window type for users who often change print settings in order to make various kinds of

prints.

❖❖❖❖ Custom Setting
This is the window type for users who rarely change print settings when making prints. The Custom

Setting display may vary depending on the installed options.
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Making default printer settings

Making the default printer settings, first open the Printer Properties dialog box from the [Printers] window.

Note

❒ With some applications, the printer driver settings are not used, and the application's own default

settings are applied.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click to select the icon of the printer you want to use.

CCCC On the [File] menu, click [Properties].

Note

❒ When you open the Printer Properties dialog box for the first time after installing the RPCS printer

driver, the confirmation window appears. After that, the initial display of the Printer Properties di-

alog box appears.

DDDD Make the necessary settings, and then click [OK].
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----If a message is displayed during installation of the printer driver

When there is a driver in the computer that is newer than the one currently being installed, a message

dialog box appears.

In such a case, you cannot install with the Auto Run program. Use the driver that was used in installing

the driver that is displayed in the message, and reinstall with [Add Printer].

A Click [Start], point to [Settings], and then click [Printers].

B Double-click the [Add Printer] icon.

C Follow the wizard to install the driver.

If the printer driver disk is a CD-ROM, the sources of installation are as follows. If the installer starts

up, click [Cancel] to quit it.

• RPCS

DRIVERS\RPCS\WIN9X_ME\(Language)\DISK1
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Making printer settings from an application

To make the printer settings for a specific application, open the Printer Properties dialog box from that

application. The following example describes how to make settings for the WordPad application that

comes with Windows 95/98/Me.

Note

❒ The actual procedure you should follow to open the Printer Properties dialog box may differ depend-

ing on the application. For more information, see the documentation that comes with the application

you are using.

❒ With some applications, the printer driver settings are not used, and the application's own default

settings are applied.

❒ Any settings you make in the following procedure are valid for the current application only.

AAAA On the [File] menu, click [Print].

The [Print] dialog box appears.

BBBB Select the printer you want to use in the [Name] list box, and then click [Properties].

The Printer Properties dialog box appears.

CCCC Make the necessary settings, and then click [OK].

DDDD Click [OK] to start printing.
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Windows 2000 - Accessing the Printer Properties

Making printer default settings - Printer Properties

Limitation

❒ To change the printer settings requires Manage Printers permission. Members of the Administrators

and Power Users groups have Manage Printers permission by default. When you set up options,

log on using an account that has Manage Printers permission.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click to select the icon of the printer you want to use.

CCCC On the [File] menu, click [Properties].

The Printer Properties dialog box appears.

Note

❒ When you open the Printer Properties dialog box for the first time after installing the RPCS printer

driver, the confirmation window appears. After that, the initial display of the Printer Properties di-

alog box appears.

DDDD  Make the necessary settings, and then click [OK].

Note

❒ Settings you make here are used as the default settings for all applications.

❒ Do not set [Form to Tray Assignment].
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----If a message is displayed during installation of the printer driver

When there is a driver in the computer that is newer than the one currently being installed, a message

dialog box appears.

In such a case, you cannot install with the Auto Run program. Use the driver that was used in installing

the driver that is displayed in the message, and reinstall with [Add Printer].

A Click [Start], point to [Settings], and then click [Printers].

B Double-click the [Add Printer] icon.

C Follow the wizard to install the driver.

If the printer driver disk is a CD-ROM, the sources of installation are as follows. If the installer starts

up, click [Cancel] to quit it.

• RPCS

DRIVERS\RPCS\WIN2K_XP\(Language)\DISK1
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Making printer default settings - Printing Preferences Properties

Limitation

❒ To change the printer settings requires Manage Printers permission. Members of the Administrators

and Power Users groups have Manage Printers permission by default. When you set up options,

log on using an account that has Manage Printers permission.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click to select the icon of the printer you want to use.

CCCC On the [File] menu, click [Printing Preferences...].

The Printing Preferences Properties dialog box appears.

DDDD Make the necessary settings, and then click [OK].

Note

❒ Settings you make here are used as the default settings for all applications.
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Making printer settings from an application

To make the printer settings for a specific application, open the Printing Preferences Properties from

that application. The following example describes how to make settings for the WordPad application

that comes with Windows 2000.

Note

❒ The actual procedures you should follow to open the Printing Preferences Properties may differ de-

pending on the application. For more information, see the documentation that comes with the appli-

cation you are using.

❒ Any settings you make in the following procedure are valid for the current application only.

AAAA On the [File] menu, click [Print...].

The [Print] dialog box appears.

BBBB Select the printer you want to use in the [Select Printer] box.

CCCC Make the necessary settings, and then click [Apply] to start your printing.
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Windows XP, Windows Server 2003 - Accessing the Printer Properties

Making printer default settings - Printer Properties

Limitation

❒ To change the printer settings requires Manage Printers permission. Members of the Administrators

and Power Users groups have Manage Printers permission by default. When you set up options,

log on using an account that has Manage Printers permission.

AAAA Access the [Printers and Faxes] window from [Start] on the taskbar.

The [Pritners and Faxes] window appears.

BBBB Click to select the icon of the printer you want to use.

CCCC On the [File] menu, click [Properties].

The Printer Properties dialog box appears.

Note

❒ When you open the Printer Properties dialog box for the first time after installing the RPCS printer

driver, the confirmation window appears. After that, the initial display of the Printer Properties di-

alog box appears.

DDDD  Make the necessary settings, and then click [OK].

Note

❒ Settings you make here are used as the default settings for all applications.

❒ Do not set [Form to Tray Assignment].
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----If a message is displayed during installation of the printer driver

When there is a driver in the computer that is newer than the one currently being installed, a message

dialog box appears.

In such a case, you cannot install with the Auto Run program. Use the driver that was used in installing

the driver that is displayed in the message, and reinstall with [Add Printer].

A Access the [Printers and Faxes] window from [Start] on the taskbar.

B Double-click the [Add Printer] icon.

C Follow the wizard to install the driver.

If the printer driver disk is a CD-ROM, the sources of installation are as follows. If the installer starts

up, click [Cancel] to quit it.

• RPCS

DRIVERS\RPCS\WIN2K_XP\(Language)\DISK1
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Making printer default settings - Printing Preferences Properties

Limitation

❒ To change the printer settings requires Manage Printers permission. Members of the Administrators

and Power Users groups have Manage Printers permission by default. When you set up options,

log on using an account that has Manage Printers permission.

AAAA Access the [Printers and Faxes] window from [Start] on the taskbar.

The [Pritners and Faxes] window appears.

BBBB Click to select the icon of the printer you want to use.

CCCC On the [File] menu, click [Printing Preferences...].

The Printing Preferences Properties dialog box appears.

DDDD Make the necessary settings, and then click [OK].

Note

❒ Settings you make here are used as the default settings for all applications.
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Making printer settings from an application

To make the printer settings for a specific application, open the Printing Preferences Properties from

that application. The following example describes how to make settings for the WordPad application

that comes with Windows XP.

Note

❒ The actual procedures you should follow to open the Printing Preferences Properties may differ de-

pending on the application. For more information, see the documentation that comes with the appli-

cation you are using.

❒ Any settings you make in the following procedure are valid for the current application only.

AAAA On the [File] menu, click [Print...].

The [Print] dialog box appears.

BBBB Select the printer you want to use in the [Select Printer] box.

CCCC Make the necessary settings, and then click [Apply] to start your printing.
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Windows NT 4.0 - Accessing the Printer Properties

Making default printer settings - Printer Properties

Limitation

❒ To change the printer settings requires Full Control permission. Members of Administrators, Server

Operators, Print Operators, and Power Users groups have Full Control permission by default. When

you set up options, log on using an account that has Full Control permission.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click to select the icon of the printer you want to use.

CCCC On the [File] menu, click [Properties].

The Printer Properties dialog box appears.

Note

❒ When you open the Printer Properties dialog box for the first time after installing the RPCS printer

driver, the confirmation window appears. After that, the initial display of the Printer Properties di-

alog box appears.

DDDD Make the necessary settings, and then click [OK].

Note

❒ Settings you make here are used as the default settings for all applications.

❒ Do not set [Form to Tray Assignment].
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----If a message is displayed during installation of the printer driver

When there is a driver in the computer that is newer than the one currently being installed, a message

dialog box appears.

In such a case, you cannot install with the Auto Run program. Use the driver that was used in installing

the driver that is displayed in the message, and reinstall with [Add Printer].

A Click [Start], point to [Settings], and then click [Printers].

B Double-click the [Add Printer] icon.

C Follow the wizard to install the driver.

If the printer driver disk is a CD-ROM, the sources of installation are as follows. If the installer starts

up, click [Cancel] to quit it.

• RPCS

DRIVERS\RPCS\NT4\(Language)\DISK1
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Making default printer settings - Default Document Properties

Limitation

❒ To change the printer settings requires Full Control access permission. Members of the Administra-

tors, Server Operators, Print Operators, and Power Users groups have Full Control permission by

default. When you set up options, log on using an account that has Full Control permission.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click to select the icon of the printer you want to use.

CCCC On the [File] menu, click [Document Defaults...].

The Default Document Properties dialog box appears.

DDDD Make the necessary settings, and then click [OK].

Note

❒ Settings you make here are used as the default settings for all applications.
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Making printer settings from an application

To make the printer settings for a specific application, open the Printer Properties dialog box from that

application. The following example describes how to make settings for the WordPad application that

comes with Windows NT 4.0.

Note

❒ The actual procedure you should follow to open the Printer Properties dialog box may differ depend-

ing on the application. For more information, see the documentation that comes with the application

you are using.

❒ With some applications, the printer driver settings are not used, and the application's own default

settings are applied.

❒ Any settings you make in the following procedure are valid for the current application only.

AAAA On the [File] menu, click [Print].

The [Print] dialog box appears.

BBBB Select the printer you want to use in the [Name] list box, and then click [Properties].

The Printer Properties dialog box appears.

CCCC Make the necessary settings, and then click [Apply].

DDDD Click [OK] to start printing.
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PostScript 3 - Setting up for Printing

Windows 95/98/Me - Accessing the Printer Properties

There are two methods you can use to open the Printer Properties dialog box.

Making default printer settings

To make the printer default settings, first open the Printer Properties dialog box from the [Printers] window.

Note

❒ With some applications, the printer driver settings are not used, and the application's own default

settings are applied.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click to select the icon of the printer you want to use.

CCCC On the [File] menu, click [Properties].

The Printer Properties dialog box appears.

DDDD Make the necessary settings, and then click [OK].

EEEE Click [OK].
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----If a message is displayed during installation of the printer driver

When there is a driver in the computer that is newer than the one currently being installed, a message

dialog box appears.

In such a case, you cannot install with the Auto Run program. Use the driver that was used in installing

the driver that is displayed in the message, and reinstall with [Add Printer].

A Click [Start], point to [Settings], and then click [Printers].

B Double-click the [Add Printer] icon.

C Follow the wizard to install the driver.

If the printer driver disk is a CD-ROM, the sources of installation are as follows. If the installer starts

up, click [Cancel] to quit it.

• PostScript 3

DRIVERS\PS\WIN9X_ME\(Language)\DISK1
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Making printer settings from an application

To make the printer settings for a specific application, open the Printer Properties dialog box from that

application. The following example describes how to make settings for the WordPad application that

comes with Windows 95/98/Me.

Note

❒ The actual procedure you should follow to open the Printer Properties dialog box may differ depend-

ing on the application. For more information, see the documentation that comes with the application

you are using.

❒ With some applications, the printer driver settings are not used, and the application's own default

settings are applied.

❒ Any settings you make in the following procedure are valid for the current application only.

AAAA On the [File] menu, click [Print].

The [Print] dialog box appears.

BBBB Select the printer you want to use in the [Name] list box, and then click [Properties].

The Printer Properties dialog box appears.

CCCC Make the necessary settings, and then click [OK].

DDDD Click [OK] to start printing.
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Windows 2000 - Accessing the Printer Properties

Making printer default settings - Printer Properties

Limitation

❒ To change the printer settings requires Manage Printers permission. Members of the Administrators

and Power Users groups have Manage Printers permission by default. When you set up options,

log on using an account that has Manage Printers permission.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click to select the icon of the printer you want to use.

CCCC On the [File] menu, click [Properties].

The Printer Properties dialog box appears.

DDDD Make the necessary settings, and then click [OK].

Note

❒ Settings you make here are used as the default settings for all applications.

❒ Do not set [Form to Tray Assignment].
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----If a message is displayed during installation of the printer driver

When there is a driver in the computer that is newer than the one currently being installed, a message

dialog box appears.

In such a case, you cannot install with the Auto Run program. Use the driver that was used in installing

the driver that is displayed in the message, and reinstall with [Add Printer].

A Click [Start], point to [Settings], and then click [Printers].

B Double-click the [Add Printer] icon.

C Follow the wizard to install the driver.

If the printer driver disk is a CD-ROM, the sources of installation are as follows. If the installer starts

up, click [Cancel] to quit it.

• PostScript 3

DRIVERS\PS\WIN2K_XP(Language)\DISK1
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Making printer default settings - Printing Preferences Properties

Limitation

❒ To change the printer settings requires Manage Printers permission. Members of the Administrators

and Power Users groups have Manage Printers permission by default. When you set up options,

log on using an account that has Manage Printers permission.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click to select the icon of the printer you want to use.

CCCC On the [File] menu, click [Printing Preferences...].

The Printing Preferences Properties dialog box appears.

DDDD Make the necessary settings, and then click [OK].

Note

❒ Settings you make here are used as the default settings for all applications.
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Making printer settings from an application

To make the printer settings for a specific application, open the Printing Preferences Properties from

that application. The following example describes how to make settings for the WordPad application

that comes with Windows 2000.

Note

❒ The actual procedures you should follow to open the Printing Preferences Properties may differ de-

pending on the application. For more information, see the documentation that comes with the appli-

cation you are using.

❒ Any settings you make in the following procedure are valid for the current application only.

AAAA  On the [File] menu, click [Print...].

The [Print] dialog box appears.

BBBB Select the printer you want to use in the [Select Printer] box.

CCCC  Make the necessary settings, and then click [Print] to start your printing.
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Windows XP, Windows Server 2003 - Accessing the Printer Properties

Making printer default settings - Printer Properties

Limitation

❒ To change the printer settings requires Manage Printers permission. Members of the Administrators

and Power Users groups have Manage Printers permission by default. When you set up options,

log on using an account that has Manage Printers permission.

AAAA Access the [Printers and Faxes] window from [Start] on the taskbar.

The [Printers and Faxes] window appears.

BBBB Click to select the icon of the printer you want to use.

CCCC On the [File] menu, click [Properties].

The Printer Properties dialog box appears.

DDDD Make the necessary settings, and then click [OK].

Note

❒ Settings you make here are used as the default settings for all applications.

❒ Do not set [Form to Tray Assignment].



Operating Instructions Client Reference

227

----If a message is displayed during installation of the printer driver

When there is a driver in the computer that is newer than the one currently being installed, a message

dialog box appears.

In such a case, you cannot install with the Auto Run program. Use the driver that was used in installing

the driver that is displayed in the message, and reinstall with [Add Printer].

A Access the [Printers and Faxes] window from [Start] on the taskbar.

B Double-click the [Add Printer] icon.

C Follow the wizard to install the driver.

If the printer driver disk is a CD-ROM, the sources of installation are as follows. If the installer starts

up, click [Cancel] to quit it.

• PostScript 3

DRIVERS\PS\WIN2K_XP\(Language)\DISK1
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Making printer default settings - Printing Preferences Properties

Limitation

❒ To change the printer settings requires Manage Printers permission. Members of the Administrators

and Power Users groups have Manage Printers permission by default. When you set up options,

log on using an account that has Manage Printers permission.

AAAA Access the [Printers and Faxes] window from [Start] on the taskbar.

The [Printers and Faxes] window appears.

BBBB Click to select the icon of the printer you want to use.

CCCC On the [File] menu, click [Printing Preferences...].

The Printing Preferences Properties dialog box appears.

DDDD Make the necessary settings, and then click [OK].

Note

❒ Settings you make here are used as the default settings for all applications.
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Making printer settings from an application

To make the printer settings for a specific application, open the Printing Preferences Properties from

that application. The following example describes how to make settings for the WordPad application

that comes with Windows XP.

Note

❒ The actual procedures you should follow to open the Printing Preferences Properties may differ de-

pending on the application. For more information, see the documentation that comes with the appli-

cation you are using.

❒ Any settings you make in the following procedure are valid for the current application only.

AAAA  On the [File] menu, click [Print...].

The [Print] dialog box appears.

BBBB Select the printer you want to use in the [Select Printer] box.

CCCC  Make the necessary settings, and then click [Print] to start your printing.
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Windows NT 4.0 - Accessing the Printer Properties

Making default printer settings - Printer Properties

Limitation

❒ To change the printer settings requires Full Control permission. Members of Administrators, Server

Operators, Print Operators, and Power Users groups have Full Control permission by default. When

you set up options, log on using an account that has Full Control permission.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears .

BBBB Click to select the icon of the printer you want to use.

CCCC On the [File] menu, click [Properties].

The Printer Properties dialog box appears.

DDDD Make the necessary settings, and then click [OK].

Note

❒ Settings you make here are used as the default settings for all applications.

❒ Do not set [Form to Tray Assignment].
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----If a message is displayed during installation of the printer driver

When there is a driver in the computer that is newer than the one currently being installed, a message

dialog box appears.

In such a case, you cannot install with the Auto Run program. Use the driver that was used in installing

the driver that is displayed in the message, and reinstall with [Add Printer].

A Click [Start], point to [Settings], and then click [Printers].

B Double-click the [Add Printer] icon.

C Follow the wizard to install the driver.

If the printer driver disk is a CD-ROM, the sources of installation are as follows. If the installer starts

up, click [Cancel] to quit it.

• PostScript 3

DRIVERS\PS\NT4\(Language)\DISK1
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Making default printer settings - Default Document Properties

Limitation

❒ To change the printer settings requires Full Control access permission. Members of the Administra-

tors, Server Operators, Print Operators, and Power Users groups have Full Control permission by

default. When you set up options, log on using an account that has Full Control permission.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click to select the icon of the printer you want to use.

CCCC On the [File] menu, click [Document Defaults].

The Default Document Properties dialog box appears.

DDDD Make the necessary settings, and then click [OK].

Note

❒ Settings you make here are used as the default settings for all applications.
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Making printer settings from an application

To make the printer settings for a specific application, open the Printer Properties dialog box from that

application. The following example describes how to make settings for the WordPad application that

comes with Windows NT 4.0.

Note

❒ The actual procedure you should follow to open the Printer Properties dialog box may differ depend-

ing on the application. For more information, see the documentation that comes with the application

you are using.

❒ With some applications, the printer driver settings are not used, and the application's own default

settings are applied.

❒ Any settings you make in the following procedure are valid for the current application only.

AAAA On the [File] menu, click [Print].

The [Print] dialog box appears.

BBBB Select the printer you want to use in the [Name] list box, and then click [Properties].

The Printer Properties dialog box appears.

CCCC Make the necessary settings, and then click [OK].

DDDD Click [OK] to start printing.
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Mac OS - Setting up for Printing

Making paper settings from an application

AAAA Open the file you want to print.

BBBB On the [File] menu, click [Page Setup].

CCCC Confirm that the printer you want to use is shown in [Format for:], and then use [Paper] to select

the paper size you want to use.

Under Mac OS X, this is called [Paper Size].

Note

❒ If the printer is now shown in the [Format for:] box, use the pop-up menu to display a list of avail-

able printers.

Reference

The actual appearance of the [Page Setup] dialog box depends on the application you are using.

See the documentation that comes with the Mac OS for more information.

DDDD After configuring the settings, click [OK].
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Setting up for printing from an application

AAAA Open the file you want to print.

BBBB On the [File] menu, click [Print].

CCCC Confirm that the printer is selected in the [Printer] box, and then make the printer settings.

DDDD After configuring the settings, click [Print].
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Canceling a Print Job

You can cancel printing from either this machine or a client computer. Since canceling procedures dif-

fer depending on print job status, check the job status and perform the cancellation in the following pro-

cedure:

Windows 95/98/Me/2000/XP, Windows Server 2003, Windows NT 4.0 - 
Canceling a Print Job 

AAAA Check if the print job you want to cancel is currently printing.

The print job may not be currently printing but if the data-in indicator is lit or flashing, the printer

is receiving data.

BBBB Cancel printing.
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If the print job you want to cancel is currently printing out

A Press {{{{Job Reset}}}} key on the control panel.

“Job Reset?” appears on the panel display.

B Select between canceling the job currently printing and canceling all jobs (including the job

currently printing) using {{{{UUUU}}}} or {{{{TTTT}}}} key.

Note

❒ Press the {{{{UUUU}}}} or {{{{TTTT}}}} key once, and not longer than necessary.

• When canceling only the current job

• When canceling all jobs including the current job

Note

❒ It is also possible to annul the cancellation. Resume printing is resumed by selecting “Re-

sume Print”, and then pressing {{{{# Enter}}}} key.

  Job Reset?

  Current Job

  Job Reset?

  All Jobs
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C Press {{{{# Enter}}}} key.

A confirmation message appears.

Note

❒ Printing resumes if you press {{{{Escape}}}} key at this point.

D Press {{{{# Enter}}}} key.

The job is canceled. When the cancellation procedure is complete, the message appears.

Important

❒ When the printer is being shared by multiple computers, be careful not to accidentally cancel

someone else's print job.

Note

❒ A print job that contains a large volume of data may take considerable time to stop.

❒ When the print job starts printing again, set [I/O Timeout] on the “Host Interface” menu to a

longer time.

Form Feed

Job Reset

On Line

Escape

Menu

Enter

AAL004S
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If the print job you want to cancel is not printing out

A Double-click the printer icon on the Windows taskbar.

A window appears, showing all the print jobs that are currently queuing to be printed. Check the

current status of the job you want to cancel.

Note

❒ You can also open the print job queue window by double-clicking the printer icon in the [Printer]

window.

B Select the name of the job you want to cancel.

C On the [Document] menu, click [Cancel Printing]. 

Note

❒ When this printer is used as a network printer, other user's print jobs cannot be canceled from

a client computer.

❒ Clicking [Cancel a printing document] from the [printer] menu deletes all currently queued print

jobs . However, when this printer is used as a network printer, print jobs from other user's

computer cannot be canceled from a client computer.

❒ When the print job selected in step B starts printing, it takes some time before print job it dis-

appears from the printer window.



Operating Instructions Client Reference

240

Mac OS - Canceling a Print Job

AAAA Check if the print job you want to cancel is currently printing.

The print job may not be currently printing but if the data-in indicator is lit or flashing, the printer

is receiving data.

BBBB Cancel printing.

If the print job you want to cancel is currently printing out

A Press {{{{Job Reset}}}} key on the control panel.

“Job Reset?” appears on the panel display.

B Select between canceling the job currently printing and canceling all jobs (including the job

currently printing) using {{{{UUUU}}}} or {{{{TTTT}}}} key.

• When canceling only the current job

• When canceling all jobs including the current job

Note

❒ It is also possible to annul the cancellation. Resume printing is resumed by selecting “Re-

sume Print”, and then pressing {{{{# Enter}}}} key.

  Job Reset?

  Current Job

  Job Reset?

  All Jobs
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C Press {{{{# Enter}}}} key.

A confirmation message appears.

Note

❒ Printing resumes if you press {{{{Escape}}}} key at this point.

D Press {{{{# Enter}}}} key.

The job is canceled. When the cancellation procedure is complete, the message appears.

Important

❒ When the printer is being shared by multiple computers, be careful not to accidentally cancel

someone else's print job.

Note

❒ A print job that contains a large volume of data may take considerable time to stop.

❒ When the print job starts printing again, set [I/O Timeout] on the “Host Interface” menu to a

longer time.

Form Feed

Job Reset

On Line

Escape

Menu

Enter
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If the print job you want to cancel is not printing out

A Double-click the printer's icon on the desktop.

A window appears, showing all the print jobs that are currently queuing to be printed. Check the

current status of the job you want to cancel.

Note

❒ Under Mac OS X, start Print Center.

B Select the name of the job you want to cancel.

C Click the pause icon, and then click the trash icon.

Note

❒ When this printer is used as a network printer, other user's print jobs cannot be canceled from

a client computer.
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10. Sample Print/Locked Print

You can perform Sample Print and Locked Print using the optional hard disk drive.

Limitation

❒ To use this function, the optional hard disk drive must be installed on the printer.

❒ The actual number of pages the printer can save depends on the contents of the print images. For

example, the printer can save up to 30 jobs or 1,000 pages for Sample Print and Locked Print. It

depends on the data volume.

Reference

For more information about settings for printer driver, see the printer driver's Help.

Sample Print

Use this function to print only the first set of a multiple-set print jobs. The remaining sets are saved on

the optional hard disk drive in the printer. The saved job can be printed or cancelled from the printer's

control panel.

Also, files specified for Sample Print can be printed or deleted using the Web browser. For details, see

Web Image Monitor Help. 

Important

❒ If you turn off the power switch, the job that was saved on the hard disk drive will be deleted.

❒ Sample Print files will not appear on the panel display if they have already been executed or deleted

using the Web browser before you select “Sample Print” from the control panel

❒ Sample Print files that are executed or deleted from the Web browser only after you have selected

“Sample Print” from the control panel will be shown on the panel display. However, an error mes-

sage will appear if you try to execute or delete them.
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Note

❒ You can identify the file you want to print by the User ID and the time when the job was stored.

❒ If the first set of the Sample Print file is not as you expected and you do not want to print the remain-

ing sets, delete the Sample Print file using the control panel or Web browser.

❒ If you print the remaining sets of the Sample Print file, the job in the printer is deleted automatically.

❒ The following procedures describe how to use this function with the PCL 5c or RPCS printer driver

under Windows. If you want to use this function with the PostScript 3 printer driver or on a Mac OS,

see the PostScript 3 Supplement.

AAAA From an application, select the menu command to print.

The [Print] dialog box appears.

BBBB Select the printer you want to use in the [Name] list box, and then click [Properties].

The Printer Properties dialog box appears.

CCCC From the [Job type:] box, select [Sample Print].

DDDD In the [User ID:] box, type a User ID of up to eight alphanumeric characters.

Note

❒ This is used to identify the user associated with a job.

❒ The User ID can consist of up to eight alphanumeric (a-z, A-Z, 0-9) characters.

EEEE Click [OK].

FFFF After making the necessary settings, click [OK].

GGGG Check the print job, and then select from the control panel whether to print the remaining sets

or delete them.

Reference

⇒ p.245 “Printing the Remaining Sets”

⇒ p.247 “Deleting a Sample Print File”
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Printing the Remaining Sets

AAAA Press {{{{Menu}}}} key.

“Menu” appears on the panel display.

BBBB Press {{{{UUUU}}}} or {{{{TTTT}}}} key to display “Sample Print”, and then press {{{{# Enter}}}} key.

The User ID and the time when the job was stored are displayed.

CCCC Press {{{{UUUU}}}} or {{{{TTTT}}}} key to display the file you want to print, and then press {{{{# Enter}}}} key.

Form Feed

Job Reset
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DDDD Confirm that “Print File” is displayed, and then press {{{{# Enter}}}} key.

The remaining sets are displayed.

Note

❒ To cancel printing, press {{{{Escape}}}} key.

EEEE Press {{{{# Enter}}}} key. To change the number of sets you want to print, press {{{{UUUU}}}} or {{{{TTTT}}}} key and

select the number of sets, and then press {{{{# Enter}}}} key.

The job is printed, and the job that was saved on the hard disk drive is deleted.

  Select Action:

   Print File

  Qty:  6(1-999)

  Press # to Print
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Deleting a Sample Print File

AAAA Press {{{{Menu}}}} key.

“Menu” appears on the panel display.

BBBB Press {{{{UUUU}}}} or {{{{TTTT}}}} key to display the “Sample Print” menu, and then press {{{{# Enter}}}} key.

CCCC Press {{{{UUUU}}}} or {{{{TTTT}}}} key to display the file you want to delete, and then press {{{{# Enter}}}} key.

Form Feed

Job Reset

On Line

Escape

Menu

Enter

AAL002S

  Menu:

   Sample Print

  Sample Print:

   08:56 ABCD1234
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DDDD Press {{{{UUUU}}}} or {{{{TTTT}}}} key to display “Delete File”, and then press {{{{# Enter}}}} key.

Note

❒ If you want to cancel the deletion of a Sample Print file, press {{{{Escape}}}} key.

EEEE Press {{{{# Enter}}}} key to delete the file.

The following message appears on the panel display.

FFFF Press {{{{On Line}}}} key.

“Ready” appears on the panel display.

  Select Action:

   Delete File

  08:56 ABCD1234

  Press# to Delete

  Ready
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Checking the Error Log

When a print job is not saved on the Hard Disk Drive, it remains in the error log and can be checked

using the control panel.

Limitation

❒ The error log displays up to 20 of the newest jobs. If you turn off the power switch, the errors will be

deleted.

AAAA Press {{{{Menu}}}} key.

“Menu” appears on the panel display.

BBBB Press {{{{UUUU}}}} or {{{{TTTT}}}} key to display “Sample Print”, and then press {{{{# Enter}}}} key.

The User ID and the time when the job was stored are displayed.

Form Feed

Job Reset

On Line

Escape

Menu

Enter

AAL002S

  Menu:

   Sample Print



Operating Instructions Client Reference

250

CCCC Press {{{{UUUU}}}} or {{{{TTTT}}}} key to display “Error File(s)”, and then press {{{{# Enter}}}} key.

DDDD Press {{{{UUUU}}}} or {{{{TTTT}}}} key to check the log.

Note

❒ To print a document with an error, either print or delete the job saved on the hard disk drive, and

then printing command the host computer to print again.

EEEE When you finish checking the error log, press {{{{Escape}}}} key.

The display returns to the Sample Print job selection menu.

FFFF Press {{{{On Line}}}} key.

“Ready” appears on the panel display.

  Sample Print:

   Error File(s)

  Error File(s):

   06:52 AB5D1234

  Ready
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Locked Print

Use this function to maintain privacy when printing confidential documents. Documents will not be print-

ed out automatically, unless a password is entered, using the control panel after sending the print job.

Also, files specified for Locked Printt can be printed or deleted using the Web browser. For details, see

Web Image Monitor Help. 

Important

❒ If you turn off the power switch, the job that was saved on the hard disk drive will be deleted.

❒ Locked Print files will not appear on the panel display if they have already been executed or deleted

using the Web browser before you select “Locked Print” from the control panel

❒ Locked Print files that are executed or deleted from the Web browser only after you have selected

“Locked Print” from the control panel will be shown on the panel display. However, an error message

will appear if you try to execute or delete them.

Note

❒ You can identify the file you want to print by the User ID and the time when the job was stored.

❒ After the Locked Print file is printed, the job in the printer is deleted automatically.

❒ The following procedures describe how to use this function with the PCL 5c or RPCS printer driver

under Windows. If you want to use this function with the PostScript 3 printer driver or on a Mac OS,

see the PostScript 3 Supplement.

AAAA From an application, select the menu command to print.

The [Print] dialog box appears.

BBBB Open the Printer Properties.

CCCC From the [Job type:] box, select [Locked Print].
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DDDD In the [User ID:] box, type a User ID of up to eight alphanumeric characters.

Note

❒ This is used to identify the user associated with a job.

❒ The User ID can consist of up to eight alphanumeric (a-z, A-Z, 0-9) characters.

EEEE In the [Password:] box, type a password of four digits.

Note

❒ The password must be four digits (0-9).

FFFF Command to print.

The job is saved on the hard disk drive.

GGGG Enter the password using the control panel, and then specify whether to print or delete.

Reference

⇒ p.253 “Entering the Password”

⇒ p.255 “Deleting the Locked Print File”

Limitation

❒ Print jobs are not saved on the hard disk drive in the following cases. You can check the error

log for jobs that were not saved.

• When there are 30 Sample Print and Locked Print jobs saved on the hard disk drive, and a

31st job is transmitted.

• The total number of pages saved on the hard disk drive exceeds 1,000 pages.
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Entering the Password

AAAA Press {{{{Menu}}}} key.

“Menu” appears on the panel display.

BBBB Press {{{{UUUU}}}} or {{{{TTTT}}}} key to display “Locked Print”, and then press {{{{# Enter}}}} key.

The User ID and the time when the job was stored are displayed.

CCCC Press {{{{UUUU}}}} or {{{{TTTT}}}} key to display a file you want to print, and then press {{{{# Enter}}}} key.

Form Feed

Job Reset

On Line

Escape

Menu

Enter

AAL002S

  Menu:

   Locked Print

  Locked Print

   08:56   ABCD1234
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DDDD Enter the password.

A Press {{{{UUUU}}}} or {{{{TTTT}}}} key to enter the left most digit of the password, and then press {{{{# Enter}}}}
key.

B The next digit appears.

C Enter the remaining digit of the password, and then press {{{{# Enter}}}} key.

EEEE Confirm that “Print File” is displayed, and then press {{{{# Enter}}}} key.

Note

❒ If you want to cancel printing, press {{{{Escape}}}} key.

FFFF Press {{{{# Enter}}}} key.

 The job is printed, and the job that was saved on the hard disk drive is deleted.

  Password:

  [0---]

  Password:

  [*0--]

  Select Action:

   Print File

  08:56 ABCD1234

  Press # to Print
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Deleting the Locked Print File

AAAA Press {{{{Menu}}}} key.

“Menu” appears on the panel display.

BBBB Press {{{{UUUU}}}} or {{{{TTTT}}}} key to display the “Locked Print” menu, and then press {{{{# Enter}}}} key.

CCCC Press {{{{UUUU}}}} or {{{{TTTT}}}} key to display a file you want to delete.

Form Feed

Job Reset

On Line

Escape

Menu

Enter

AAL002S

  Menu:

   Locked Print

  Locked Print

   08:56  ABCD1234
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DDDD Enter the password of the Locked Print file.

A Press {{{{UUUU}}}} or {{{{TTTT}}}} key to enter the left most digit of the password, and then press {{{{# Enter}}}}
key.

B The next digit appears.

C Repeat steps AAAA and BBBB to enter the remaining password digits, and then press {{{{# Enter}}}} key.

EEEE Press {{{{UUUU}}}} or {{{{TTTT}}}} key to display “Delete File”, and then press {{{{# Enter}}}} key.

Note

❒ If you want change the Locked Print file, press {{{{Escape}}}} key.

FFFF Press {{{{# Enter}}}} key.

“Deleted” appears on the panel display, and then the printer returns to the previous menu.

  Password:

  [0---]

  Password:

  [*0--]

  Select Action:

   Delete File
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Checking the Error Log

When a print job is not saved on the Hard Disk Drive, it remains in the error log and can be checked

using the control panel.

Limitation

❒ The error log displays up to 20 of the newest jobs. If you turn off the printer power, the errors will be

deleted.

AAAA Press {{{{Menu}}}} key.

“Menu” appears on the panel display.

BBBB Press {{{{UUUU}}}} or {{{{TTTT}}}} key to display “Locked Print”, and then press {{{{# Enter}}}} key.

The User ID and the time when the job was stored are displayed.

Form Feed

Job Reset

On Line

Escape

Menu

Enter

AAL002S

  Menu:

   Locked Print
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CCCC Press {{{{UUUU}}}} or {{{{TTTT}}}} key to display “Error File(s)”, and then press {{{{# Enter}}}} key.

DDDD Press {{{{UUUU}}}} or {{{{TTTT}}}} key to check the log.

Note

❒ To print a document with an error, either print or delete the job saved on the hard disk drive, and

then printing command the host computer to print again.

EEEE When you finish checking the error log, press {{{{Escape}}}} key.

The display returns to the Locked Print job selection menu.

FFFF Press {{{{On Line}}}} key.

“Ready” appears on the panel display.

  Locked Print:

   Error File(s)

  Error File(s):

   06:52 AB5D1234

  Ready
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11. Troubleshooting

Checking the Printer Status

SmartDeviceMonitor for Client

AAAA Start up SmartDeviceMonitor for Client.

BBBB Right-click the SmartDeviceMonitor for Client icon from the task bar, and then point and left-

click [Options] from the displayed menu.

The [SmartDeviceMonitor for Client-Options] window is displayed.

CCCC Select the printer you want to use, check [To be Monitored], and then click [OK].

DDDD Right-click the SmartDeviceMonitor for Client icon from the task bar, and then point and left-

click the printer you want to monitor.

The [Status] window of the target printer to be monitored is opened.

EEEE Click the [Configuration] tab to find the amount of paper in the Paper Tray, etc..

Note

❒ For more information about how to use each item, see the SmartDeviceMonitor for Client Help.
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Web Browser

AAAA Start up the web browser.

BBBB Type “http://(the IP address of the printer you want the status to be displayed)” for the address.

The status of the selected printer is displayed on the web browser.

CCCC Click [Status] to find the amount of paper in the Paper Tray, etc..

Note

❒ For more information about how to use each item, see the Web Image Monitor Help.
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12. Appendix

Printing a PDF File Directly

You can send PDF files directly to this machine

to print, without opening its application.

Limitation

❒ This is possible for genuine Adobe PDF files

only.

❒ Version 1.3, 1.4, and 1.5 PDF files are compat-

ible.

❒ Transparency and JBIG2 (functions of PDF

version 1.4) are not compatible.

❒ PDF version 1.5 only functions are not com-

patible. 

Printing Method

❖❖❖❖ Using DeskTopBinder V2 (Lite)
PDF files registered with DeskTopBinder V2

(Lite) can be sent directly to this machine for

printing.

Limitation

❒ The RPCS printer driver must be installed. 

❒ PDF file direct printing is not possible with

some versions DeskTopBinder V2 (Lite).

Use DeskTopBinder V2 (Lite) on the CD

supplied with this machine. 
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Note

❒ PDF Direct Print settings can be made

from PDF Direct Print properties. 

❒ To print password-protected PDF files,

you must do the following:

• Enter the PDF password using PDF Di-

rect Print properties. 

• On the control panel, press [PDF: Change

PW] on the “PDF” menu to set the PDF

password.

❒ When a group password is set with Desk-

TopBinder V2 (Lite), set a group password

using [PDF Group PW] on the “PDF” menu

on the control panel.

Reference

For details, see DeskTopBinder V2 (Lite)

Help.

❖❖❖❖ Using commands
From Windows and UNIX, you can print PDF

files directly, using commands such as “ftp”

and “lpr”.

Reference

• For more information about printing us-

ing commands under Windows, see

“Printing Files Directly from Windows”,

Administrator Reference.

• For more information about printing us-

ing commands under UNIX, see UNIX

Supplement.
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Printing with Bluetooth™ Connection

Preparation

This machine supports the following profiles:

• SPP

• HCRP

• BIP (Some machines do not support BIP.

For details, see the manual that comes

with the machine.) 

Reference

For more information about printing

with SPP, see p.263 “Printing with

Bluetooth™ Connection”

For more information about printing

with HCRP or BIP, see the manual for

each product.

For more information about the sup-

ported profiles, see the manual that

comes with the Bluetooth™ adaptor.

Printing with Bluetooth™ Connection

Preparation

Make sure you install the printer driver using

the same procedure as for the parallel inter-

face installation. For more information about

how to install the printer driver, see p.44

“Printing with Parallel Connection”.

Confirm that the followings are true:

• The power switch is on.

• The Bluetooth™ card has been inserted

into the machine and its light is blinking.

This machine is confirmed to work with com-

puter which has following Bluetooth™ adaptor.

• 3Com PCMCIA Bluetooth™ adaptor Parts#

3CRWB6096

• 3Com USB Bluetooth™ adaptor Parts#

3CRWB96

Note

❒ The system requirements depend on each

Bluetooth™ product. See the manual for each

product for more details.

❒ For more information about how to set up

Bluetooth™ under other operating systems or

for use with different utilities, see the manuals

for those operating systems or utilities.
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AAAA Run 3Com Bluetooth Connection Manager.

BBBB Make sure the printer you want to use ap-

pears in the 3Com Bluetooth Connection

Manager.

CCCC Click [COM port] on the [Tool] menu.

DDDD Make sure that the line “Bluetooth Serial

Client (COMx)” appears under Client

Ports. (x indicating the COM port number

used by Bluetooth™).

EEEE Click [Close].

FFFF Click [Start] on the taskbar, point to [Set-
tings], and then click [Printers].

The [Printers] dialog box appears.

GGGG Click the icon of the printer you want to

use.

HHHH On the [File] menu, click [Properties].

IIII Click the [Ports] tab.

JJJJ Under [Port], check [COMx:]. X is as same as

checked step D.

KKKK Click [OK].

Close the [Printers] dialog box.

❖❖❖❖ If a dialog box appears while transmit-
ting a print job, reestablish the connec-
tion as follows:

A Select the printer you want to use in the

[Softkey] box.

B Click [Connect].

Note

❒ If you always use the same printer,

check [Always use for this connection].

Reference

For more information, see the manual

that comes with the Bluetooth™ adaptor.
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Security Mode

AAAA Start 3Com Bluetooth Connection Manager.

BBBB Click [Security Mode] on the [Tools] menu.

The Security Mode dialog box appears.

CCCC Select the Security Mode from the [Security

Mode:] drop-down list box.

If you select [High], or if you select [Custom]
and then specify [Link] in the [Custom Set-

tings] dialog box, you will be asked to enter

the Bluetooth™ password. (See p.265 “Print-

ing” for details on how to find out what the

password is.) For all other Security Modes

and Custom Settings, no password will be

asked.

Note

❒ For more information about each mode,

see the user's manual for the utility.

DDDD Click [OK].

Close the Security Mode dialog box.

Printing

A Transmit the print job to the printer be-

ing used.

Depending on how your computer is set

up, the [Connect] dialog box may appear.

If it does, use it to establish a connection

with the machine.

B The [Authentication] dialog box appears.

C Enter the Bluetooth™ password and

click [OK].

The Bluetooth™ password consists of the

last four digits of the machine's serial num-

ber. You can find the serial number on the

label on the back of the machine. For ex-

ample, if the serial number is 00A0-

001234, the Bluetooth™ password is

1234.

D The print job is transmitted.

Note

❒ The Bluetooth™ password differs for

each machine and cannot be changed.
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----SPP and HCRP

• The maximum number of Bluetooth™ adaptor

or Bluetooth™-equipped computers that can

be connected at the same time by the Blue-

tooth™ interface is two, including one by SPP

connection and one by HCRP connection.

• When connecting more than one Bluetooth™

adaptor or Bluetooth™-equipped computer at

the same time, the first device which establish-

es the connection is selected. When selecting

the connection between the other devices, you

need to cancel the first established connection.

• Conditions for Bidirectional Communication

• SPP connection does not support bidirec-

tional communication.

• HCRP connection supports bidirectional

communication.

----BIP

• For BIP connection, a module which includes

PostScript 3 must be installed in the machine.

• Only one Bluetooth™ adaptor or Bluetooth™-

equipped computer can be connected using

BIP.

• The format that can be printed using BIP con-

nection is JPEG.

• User code is disabled for BIP connection.

• If the print function of the machine is set to

limited, you cannot print.

• Some machines do not support BIP. For details,

see the manual that comes with the machine.
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Color Guide

Color Printing Basics

Additive (Emitted) and Subtractive (Reflected) Color Models

All lights are a mixture of red, green, and blue, which are normally called the RGB color model. When

red, green, and blue are of equal intensities, the RGB color model produces white.

Note

❒ RGB is also called additive or emitted color. The colors on your computer screen are produced by

varying the intensities of RGB.
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Printed color is a mixture of cyan, magenta, and yellow, which are normally called the CMY color model.

When mixed in equal proportions the CMY color model produces black.

Note

❒ CMY is also called subtractive or reflective color. The printer uses CMY toner plus K (black) toner

(CMYK color model) to provide full color printing.

The colors of the RGB color model can be mixed to produce the cyan, magenta, and yellow of the CMY

color model and vice versa. Two colors of one model are mixed to produce the color of the other model

(mixing blue and green produces cyan, for example). The remaining color is the complement of the col-

or produced (red in this example). Complementary colors are: red and cyan, green and magenta, blue

and yellow.
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Printed Color

The printer produces full-color output using four toner colors: cyan, magenta, yellow, and black. These

four colors make up the CMYK color model.

Note

❒ Mixing CMY in equal proportions should hypothetically produce pure black, but imperfections in the

ink cause an equal measure of these colors to produce a muddy or dark brown. Black toner is added

to the color model in order to make it possible to produce pure black.

For example, if the image is created with cyan only, there is no problem in printing all of it with cyan

toner. However, full-color images are actually comprised of 10,000s of fine colors. These fine colors

can be expressed by changing the ratio of CMYK toner particles to be printed per unit surface.

There are also dark and light shadings to each color. These shadings can be expressed by changing the

amount of toner particles to be printed per unit surface.
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Collate

The Collate function allows you to print while sorting printouts into page-orderd sets, such as when

printing multiple copies of meeting materials, and so on.

Reference

For more information about collate and job separation, see the printer driver's Help file.

❖❖❖❖ Collate
Outputs can be assembled as sets in sequential order.

Limitation

❒ To use these functions, the optional Memory Unit of at least 192 MB or the optional hard disk drive

must be installed on the printer.

❒ Up to 150 pages can be sorted using RAM. If the optional hard disk drive is installed, up to 1,000

pages can be sorted.
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Precautions when using Windows Server 2003

Precautions when using the Terminal Server mode

The following printer driver functions are either disabled or have limitations. Disabled functions are

displayed in gray.

• Disabled functions

Locked Print, Sample Print, Overlay

• Functions that require administrator permission

Custom setting, Custom Size, Watermark, [User settings] on the [Print Quality] tab
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Displaying the [Printers and Faxes] window with Windows 
XP and Windows Server 2003

Using Windows XP Professional 
or Windows Server 2003

Follow the procedure below to display the [Print-
ers and Faxes] window under Windows XP Pro-

fessional or Windows Server 2003.

AAAA On the [Start] menu, click [Printers and Faxes].

The [Printers and Faxes] window appears.

Using Windows XP Home Edition

Follow the procedure below to display the [Print-
ers and Faxes] window under Windows XP

Home Edition.

AAAA On the [Start] menu, click [Control Panel].

BBBB Click [Printers and Other Hardware].

CCCC Click [Printers and Faxes].

The [Printers and Faxes] window is displayed.
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Installing the Font Manager 2000

Limitation

❒ If your system is Windows 2000/Windows XP, Windows Server 2003 or Windows NT 4.0, installing

software by Auto Run requires Administrators permission. When you install a printer driver by Auto

Run, log on using an account that has Administrators permission.

AAAA Close all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

CCCC Select [Font Manager 2000].

DDDD Follow the instructions on the screen.
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Using Adobe PageMaker Version 6.0, 6.5 or 7.0

If you use the machine under Windows 95/98/Me/2000/XP, Windows Server 2003, or Windows NT

4.0 with Adobe PageMaker, you need to copy the PPD file to the PageMaker folder. 

The PPD file is the file with extension “.ppd” in the folder “DRIVERS\PS\WIN9X_ME\(Lan-

guage)\DISK1\” on the CD-ROM. 

The “WIN9X_ME” folder, inside the “PS” folder is for Windows 95/98/Me. Use the folder at this level

that is appropriate for the operating system you are currently using.

The third folder, “(Language)” may be substituted by an appropriate language name. 

Copy the file with extension “.ppd” to the PageMaker folder.

• For PageMaker 6.0 default installation

The directory is “C:\PM6\RSRC\PPD4”.

• For PageMaker 6.5 default installation

The directory is “C:\PM65\RSRC\USENGLISH\PPD4”.

The “USENGLISH” may vary depending on your language selection.

• For PageMaker 7.0 default installation

The directory is “C:\PM7\RSRC\USENGLISH\PPD4”.

The “USENGLISH” may vary depending on your language selection.
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Deleting a Sample Print File,   247

Deleting the Locked Print File,   255

E

Entering the Password,   253
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Mac OS,   164

Installing Software

Windows 2000,   68

Windows 95/98/Me,   31

Windows NT 4.0,   134

Windows Server 2003,   100

Windows XP,   100

Installing the Adobe Type Manager

Mac OS,   163

Installing the ColorSync profile

Mac OS,   162

Installing the PostScript Printer Driver and PPD File

Mac OS,   157

Installing the PPD File

Mac OS X,   166
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Mac OS,   157
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PageMaker,   274

PCL 5c,   181

PDF Direct Print,   261

PostScript,   182

Precautions when using the Terminal Server mode

Windows Server 2003,   271

Precautions when using Windows Server 2003

Windows Server 2003,   271

Printer driver,   180
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Mac OS,   172
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PDF Direct Print,   261
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PDF Direct Print,   261
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Setting up the Printer Driver and 

Canceling a Print Job,   188

SmartDeviceMonitor for Admin,   183

SmartDeviceMonitor for Client,   185

Software and Utilities Included on the CD-ROM,   178

Sorting copies into sets,   270

Subtractive (Reflected) Color Models,   267

T

Troubleshooting,   259

U

USB Printing Support,   178

Using Rendezvous

Mac OS X,   169

Using USB Interface

Mac OS,   165

Mac OS X,   168

W

Windows 2000,   57

printer properties, PCL5c,   191

printer properties, PostScript 3,   222

printer properties, RPCS,   207

Windows 95/98/Me,   22

printer properties, PCL5c,   188

printer properties, PostScript 3,   219
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Windows Server 2003,   91

printer properties, PCL5c,   195

printer properties, PostScript 3,   226

printer properties, RPCS,   211

Windows Setup
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